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Obsah dodávky 

 

Obsah dodávky: 

 D-Link AirPlus G DI-524 
802.11/2,4GHz bezdrátový směrovač 

 Napájecí adaptér 7,5V ss, 1,5 A 

 Návod a záruka na CD 

 Návod na rychlou instalaci  

 Ethernetový kabel (všechny ethernetové porty na DI-524 jsou 
typu auto-MDIX) 

Poznámka: Použití napájecího zdroje s jiným jmenovitým napětím, než jaké má na-
pájecí zdroj dodávaný s DI-524, poškodí zařízení a způsobí ztrátu záruky. 

Pokud některá z výše uvedených položek chybí, kontaktujte prodejce. 

Systémové požadavky pro konfiguraci: 

 Ethernetový kabelový nebo DSL modem 

 Počítač s operačním systémem Windows, Macintosh nebo Li-
nux s nainstalovanou ethernetovou síťovou kartou 

 Internet Explorer verze 6.0 nebo Netscape Navigator verze 
7.0 a vyšší 
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Úvod 
D-Link AirPlus G DI-524 High-Speed Wireless Router je 802.11g vysokorychlostní 
výkonný bezdrátový směrovač, který podporuje vysokorychlostní bezdrátové sítě 
v domácnostech, ve firmách nebo na veřejných místech. 
 

Na rozdíl od většiny směrovačů přenáší DI-524 data rychlostí až 108 Mb/s (ve srov-

nání se standardní rychlostí 54 Mb/s), pokud je použit spolu s dalšími výrobky řady 

D-Link AirPlus G. Standard 802.11g je zpětně kompatibilní se zařízeními používají-

cími  standard 802.11b. To znamená, že pro zachování funkce sítě není zapotřebí 

měnit všechny její části. Použijete-li zařízení 802.11g společně s 802.11b, obětujete 

sice část rychlosti 802.11g, ale neztratíte možnost komunikace ve stávající síti. Tuto 

síť můžete pak postupně vylepšovat náhradou dosavadních pomalejších zařízení 

802.11b za novější 802.11g. 
 
Kromě vyšší rychlosti při použití spolu s dalšími zařízeními s protokolem 802.11g má 
DI-524 nejnovější, nejodolnější a nejdokonalejší bezpečnostní funkce, jaké jsou 
dnes k dispozici. Při použití s dalšími zařízeními, která jsou kompatibilní s WPA (Wi-
Fi Protected Access) a 802.1x v síti s RADIUS serverem lze využívat tyto bezpeč-
nostní funkce: 

WPA: Wi-Fi Protected Access autorizuje a identifikuje uživatele podle tajného 
klíče, který se automaticky mění v pravidelných intervalech. WPA používá 
TKIP (Temporal Key Integrity Protocol) pro změnu dočasného klíče po 
každých 10 000 paketech (paket je druh zprávy přenášené v síti). To zaru-
čuje mnohem větší bezpečnost než standardní zabezpečení WEP. (Na 
rozdíl od WPA bylo u staršího šifrování WEP zapotřebí provádět změnu 
klíče ručně.)  

802.1x: Autentizace je první obrannou linií proti průniku do sítě. Při autentizačním 
procesu server prověřuje identitu klienta, který se pokouší připojit k síti. 
Neznámým klientům bude přístup zamítnut. 

 
Pro uživatele v domácnostech, kteří nebudou používat ve své síti RADIUS server, 
bude i tak zabezpečení při použití DI-524 spolu s dalšími zařízeními 802.11g mno-
hem lepší než dříve. Pomocí režimu Pre Shared Key ve WPA získá DI-524 nový 
bezpečnostní klíč při každém připojení k síti 802.11g. Stačí, abyste zadali do konfi-
guračního menu data pro šifrování jen jednou. Pro zajištění bezpečnosti pak už  
u DI-524 nebudete muset nikdy ručně zadávat stále nový WEP klíč, což významně 
zvýší bezpečnost vaší komunikace.  
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Připojení 

 
 

Všechny ethernetové porty (WAN 
a LAN) jsou auto MDI/MDIX, což zna-
mená, že můžete použít přímý nebo 
překřížený ethernetový kabel. 

Stisknutím tlačítka 
Reset se obnoví 
výchozí tovární 
nastavení směro-
vače. 

Zásuvka pro 
napájecí 
adaptér 

LAN porty auto 
MDI/MDIX  při 
připojení 
k počítačům 
s ethernetovým 
rozhraním auto-
maticky zjistí typ 
kabelu. 

WAN port auto 
MDI/MDIX je určen 
pro připojení ke 
kabelovému nebo 
DSL modemu po-
mocí ethernetové-
ho kabelu. 
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LED indikátory 
 

 

Indikátor WAN 
Stálé svícení 
indikuje připojení 
k portu WAN. 
Blikání indikuje 
přenos dat. 

Indikátor WLAN 
Stálé svícení in-
dikuje připojení 
k bezdrátovému 
segmentu. Blikání 
indikuje přenos 
dat. 

Indikátor POWER 
Stálé svícení indiku-
je správné připojení 
napájecího napětí. 

Indikátor STATUS 
Blikání indikuje, že 
je DI-524 připraven. 

Indikátory LOKÁLNÍ 
SÍTĚ 
Stálé svícení indikuje 
připojení portu 1–4 
k počítači s etherne-
tovým rozhraním. 
Blikání indikuje pře-
nos dat. 
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Vlastnosti 
Plná kompatibilita se standardem 802.11g zajišťuje bezdrátový přenos dat 

rychlostí až 54 Mb/s. 

Zpětná kompatibilita se standardem 802.11b zajišťuje bezdrátový přenos dat 

rychlostí až 11 Mb/s. 

WPA (Wi-Fi Protected Access) autorizuje a identifikuje uživatele podle tajného 

klíče, který se mění v pravidelných intervalech, například: 

TKIP (Temporal Key Integrity Protocol) spolu s RADIUS serverem mění 

dočasný klíč po každých 10 000 paketech, čímž zajišťuje vyšší bezpeč-

nost. 

Režim Pre Shared Key znamená, že domácí uživatel, který nemá 

RADIUS server, získá nový bezpečnostní klíč při každém připojení k síti, 

což významně zvýší bezpečnost komunikace v síti. 

802.1x autentizace spolu s RADIUS serverem ověřuje identitu klientů, kteří 

se chtějí připojit 

Využití technologie OFDM (Orthogonal Frequency Division Multiplexing) 

Snadná konfigurace a diagnostika 

Provoz v pásmu 2,4 GHz 

 Připojení více počítačů k širokopásmovému (kabelovému nebo DSL) modemu 

pro sdílení připojení k Internetu 

Rozšířené funkce firewallu: 

Podpora NAT s VPN přenosem pro zvýšení bezpečnosti 

Filtrování MAC  

Filtrování IP 

Filtrování URL 

Blokování domén 

Časová rozvrh 

 Server DHCP umožňuje přidělit všem počítačům v síti IP adresu 

Webové rozhraní pro správu a konfiguraci. 

Řízení přístupu uživatelů k síti. 

Podpora speciálních aplikací, které požadují vícenásobné připojení. 

Vybaven 4 ethernetovými porty 10/100 Mb/s, 1 portem WAN, auto MDI/MDIX 
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Základy bezdrátové komunikace 
 
Zařízení pro bezdrátovou komunikaci D-Link jsou založena na průmyslových stan-
dardech a poskytují snadno použitelné a kompatibilní vysokorychlostní bezdrátové 
připojení doma, v kanceláři nebo ve veřejně přístupných bezdrátových sítích. Bez-
drátová zařízení D-Link vám umožní získat kdykoli a kdekoli přístup k požadovaným 
datům. Budete si moci užívat svobody, kterou bezdrátová počítačová síť přináší. 
Bezdrátová lokální síť (WLAN) je buňková počítačová síť, která vysílá a přijímá data 
pomocí rádiových signálů namísto kabelů. Bezdrátové LAN jsou stále více používá-
ny v domácnostech, kancelářích i ve veřejných prostorách, jako jsou letiště, kavárny 
a univerzity. Inovativní způsoby využití technologie WLAN pomáhá lidem pracovat a 
komunikovat mnohem efektivněji. Zvýšená pohyblivost a absence kabelů a další 
pevné infrastruktury se ukázaly být pro mnohé uživatele výhodou.  
Uživatelé bezdrátové sítě mohou používat stejné aplikace jako uživatelé klasické 
kabelové sítě. Karty adaptérů pro bezdrátovou komunikaci používané u mobilních 
i stolních počítačů podporují stejné protokoly jako karty adaptérů Ethernetu.  
 
Lidé používají technologii bezdrátové LAN z mnoha různých důvodů: 
 

Mobilita – Mají-li lidé přístup k datům v libovolném místě v provozním dosahu 

WLAN, zvýší se jejich produktivita. Manažerská rozhodnutí na základě informací 
získaných v reálném čase mohou významně zvýšit efektivitu pracovníků.. 

Nízké náklady na implementaci – Sítě WLAN se snadno instalují, ovládají, 

mění a přemisťují. Sítě, které se často mění, mohou těžit z výhod snadné instalace 
WLAN. WLAN může pracovat v místech, kde by byla instalace kabelů neúčelná ne-
bo neproveditelná. 

Instalace a rozšíření sítě – Instalace systému bezdrátové LAN může být rychlá a 

snadná a může odstranit potřebu protahovat kabely skrz zdi a stropy. Bezdrátová 
technologie umožňuje rozšíření sítě do míst, kam nelze zavést kabely – dokonce 
mimo domov nebo kancelář 

Přizpůsobitelnost – Bezdrátové LAN lze konfigurovat do mnoha uspořádání (to-

pologií) podle potřeb konkrétních aplikací a instalací. Konfigurace lze snadno měnit v 
rozmezí od sítí typu peer-to-peer, vhodných pro malý počet uživatelů, až po rozsáhlé 
infrastrukturní sítě se stovkami nebo tisícovkami uživatelů podle počtu použitých 
bezdrátových zařízení. 

Levné řešení – Ceny bezdrátových síťových zařízení jsou srovnatelné s cenou 

konvenčních ethernetových síťových zařízení. 
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Základy bezdrátové komunikace (pokračování) 

 

Technologie založená na standardech 
 
Bezdrátový širokopásmový směrovač používá standard 802.11g. 

Standard IEEE 802.11g je rozšířením standardu 802.11b. Zvyšuje rychlost přenosu 
dat až na 54 Mb/s v pásmu 2,4 GHz s využitím technologie OFDM. 

To znamená, že ve většině prostředí v daném dosahu zařízení budete moci rychle 
přenášet rozsáhlé soubory nebo dokonce sledovat film ve formátu MPEG bez zna-
telného zpoždění. Toto zařízení používá pro rychlý přenos digitálních dat pomocí 
rádiových vln technologii OFDM (Orthogonal Frequency Division Multiplexing). 
OFDM pracuje tak, že rozdělí rádiový signál na několik menších subsignálů, které 
jsou pak souběžně vysílány na různých frekvencích do přijímače. OFDM snižuje 
množství přeslechů (interferencí) při přenosu signálu.  

DI-524 je zpětně kompatibilní se zařízeními 802.11b. To znamená, že pokud máte již 
existující síť 802.11b, budou zařízení v této síti kompatibilní se zařízeními 802.11g 
při rychlostech až do 11 Mb/s v pásmu 2,4 GHz. 
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Základy bezdrátové komunikace (pokračování) 

 

Podmínky pro instalaci 
 
D-Link AirPlus G DI-524 umožňuje bezdrátový přístup k síti prakticky odkudkoli 
v provozním dosahu zařízení. Mějte však na paměti, že počet, síla a rozmístění zdí, 
stropů a jiných objektů, kterými musí signál procházet, může dosah snížit. Dosah se 
obvykle mění v závislosti na druhu materiálů a úrovni rádiového rušení v místě pou-
žití. Klíčem k dosažení maximálního dosahu je dodržovat tyto základní pokyny:  

1 Dbejte na to, aby byl počet zdí a stropů mezi DI-524 a ostatními síťovými za-

řízeními co nejmenší. Každá zeď nebo strop může snížit dosah zařízení pro 
bezdrátovou komunikaci D-Link o 1 až 30 metrů. Umístěte zařízení tak, aby 
byl počet zdí a stropů mezi nimi co nejmenší. 

2 Uvažujte o překážkách signálu ve směru přímé spojnice mezi síťovými zaří-

zeními. Zeď silná 0,5 metru se při průchodu signálu pod úhlem 45° jeví, jako 
by měla tloušťku téměř jeden metr. Při úhlu 2° vypadá, jako by měla tloušťku 
přes 14 metrů! Pro lepší přenos dat umístěte zařízení tak, aby signál pro-
cházel zdmi a stropy přímo co nejkratší cestou. 

3 Šíření rádiového signálu ovlivňuje druh stavebního materiálu. Pevné kovové 

dveře nebo hliníkové profily mohou dosah negativně ovlivnit. Zkuste umístit 
bezdrátová zařízení a počítače s adaptéry bezdrátové sítě tak, aby signál 
procházel přes suché zdi nebo dveřní otvory a ne přes jiné materiály. 

4 Mějte zařízení v dostatečné vzdálenosti (nejméně 1–2 metry) od elektrických 

přístrojů a zařízení, která mohou vytvářet silný rušivý rádiový signál. 
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Začínáme 

 
Všimněte si, že bezdrátová zařízení D-Link AirPlus G jsou výrobcem standardně 

nakonfigurována tak, aby se bez dalšího zásahu sama navzájem propojila.  

Pro vytvoření typické domácí bezdrátové sítě  
(viz obrázek výše) postupujte takto: 

 Budete potřebovat širokopásmový přístup na Internet (kabelová/DSL linka do 

domácnosti nebo kanceláře).  

 Poraďte se s poskytovatelem kabelového/DSL připojení o správné instalaci 

modemu. 

 Připojte kabelový nebo DSL modem k širokopásmovému bezdrátovému smě-

rovači DI-524 (viz Návod na rychlou instalaci dodávaný se směrovačem) 

 Připojujete-li do sítě stolní počítač, nainstalujte do volného PCI slotu počítače 

bezdrátový PCI adaptér D-Link AirPlus G DWL-G510. Můžete nainstalovat ta-

ké DWL-G510 nebo DWL-520. (Viz návod na rychlou instalaci dodávaný se 

síťovým adaptérem)  

 Nainstalujte do notebooku bezdrátový CardBus adaptér D-Link DWL-G630.  

 (Viz návod na rychlou instalaci dodávaný s DWL-G630.) 

 Pro připojení přes kabel nainstalujte do stolního počítače síťovou kartu D-Link 

DFE-530TX+. Čtyři ethernetové porty LAN jsou typu auto MDI/MDIX a budou 

pracovat s přímým i překříženým kabelem.  

 (Viz návod na rychlou instalaci dodávaný s DFE-530TX+.) 
 

Kabelový/DSL modem 

Počítač 3 
Stolní počítač nebo laptop 
(s bezdrátovým adaptérem) 

Počítač 2 
Stolní počítač nebo laptop 
(s bezdrátovým adaptérem) 

Počítač 1 
Stolní počítač 
nebo laptop 

Bezdrátový směrovač 

1 
2 

3 

5 

4 

6 

Schéma  
bezdrátové  
infrastrukturní 
sítě 
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Použití konfiguračního menu 
Když chcete nakonfigurovat vaši síť nebo DI-524, 
můžete vyvolat konfigurační menu spuštěním 
webového prohlížeče a zadáním IP adresy smě-
rovače DI-524. Výchozí IP adresa DI-524 je uve-
dena vpravo:  

 Spusťte webový prohlížeč. 
 Zadejte IP adresu směrovače 

(http://192.168.0.1) 

Poznámka: Pokud výchozí IP adresu DI-524 
změníte, zadejte správnou aktuální IP adresu. 

 V poli User Name (Jméno uživatele) zadej-
te admin. 

 Pole Password (Heslo) ponechejte prázd-
né. 

 Klikněte na OK.  
 

 

Objeví se okno Ho-
me>Wizard. Další infor-
mace o použití průvodce 
instalací Setup Wizard viz 
Návod na rychlou instala-
ci. 
 
 

Home > Wizard 

 
 

Tato tlačítka se objevují 
ve většině konfiguračních 
oken v této části. Po pro-
vedení změn konfigurace 
klikněte na příslušné 
tlačítko v dolní části okna. 

 

 Kliknutím na Apply se uloží změny provedené 

na stránce. 

 Kliknutím na Cancel se zruší změny provedené 

na stránce. 

 

 Kliknutím na Help se zobrazí užitečné informa-

ce o stránce. 

 Kliknutím na Restart se restartuje směrovač. 

(Potřebné pro některé změny.) 
 

http://192.168.0.1 
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Použití konfiguračního menu (pokračování) 

 
 Home > Wireless 

 

Network ID 
(SSID)- 
(Název sítě) 

Service Set Identifier (SSID) je jméno zvolené pro konkrétní 
místní bezdrátovou počítačovou síť (WLAN). Standardně je 
výrobcem nastaveno jméno „default“. SSID lze snadno změ-
nit pro připojení k existující bezdrátové síti nebo pro vytvoření 
nové bezdrátové sítě. 

Channel- 
(Kanál) 

Výchozí nastavení kanálu je 6. Všechna zařízení v síti musí 
sdílet stejný kanál. (Poznámka: Bezdrátová adaptéry budou 
automaticky zjišťovat a kontrolovat nastavení bezdrátové 
komunikace.)  

Security- 
(Zabezpečení) 

Zvolte zabezpečení None (žádné), WEP, 802.1X, WPA-PSK 
nebo WPA. None je výchozí nastavení. (Poznámka: Zapnete-
li šifrování na DI-524, musíte je zapnout také na všech bez-
drátových klientech, jinak nelze navázat bezdrátové spojení.) 

WEP Encryption- 
(WEP šifrování) 

Nastavuje požadovanou úroveň šifrování: 64 nebo 128bitové 

Key Mode- 
(Typ klíče) 

Nastavuje typ klíče: HEX (hexadecimální) nebo ASCII (zna-
kový)  

Keys 1-4- 
(Klíče 1-4) 

Můžete zadat až 4 WEP klíče. Vyberte jeden, který chcete 
použít. 
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Použití konfiguračního menu (pokračování) 

 Home > WAN > Dynamic IP Address 

 

Dynamic IP  
Address- 
(Dynamická IP  
adresa) 

Zvolte Dynamic IP Address, abyste získali IP adresu automa-
ticky od vašeho poskytovatele připojení k internetu (ISP). 
Použijte, pokud nemáte od ISP přidělenou pevnou IP adresu 
(obvykle při připojení přes kabelový modem). 

Host Name-  
(Název hostitele) 

Pole Host Name je volitelné, ale může být požadováno ně-
kterými ISP. Výchozí Host Name je jméno zařízení široko-
pásmového směrovače a lze je změnit. 

MAC Address-  
(MAC adresa) 

Výchozí MAC adresa je nastavena na MAC adresu fyzického 
rozhraní WAN širokopásmového směrovače. Nedoporučuje 
se měnit standardní MAC adresu, pokud to váš ISP nevyža-
duje.  

Clone MAC  
Address-  
(Klonovat MAC  
adresu) 

Výchozí MAC adresa je nastavena na MAC adresu fyzického 
rozhraní WAN širokopásmového směrovače. Pokud má ISP 
zaregistrovanou MAC adresu síťové karty vašeho PC, může-
te použít tlačítko „Clone MAC Address“ pro zkopírování této 
MAC adresy. Nedoporučuje se měnit standardní MAC adre-
su, pokud to váš ISP nevyžaduje. 

Prima-
ry/Secondary 
DNS Address-  

Zadejte adresu primárního/sekundárního DNS serveru, po-
kud nechcete používat tu, kterou máte od vašeho ISP. 
 

MTU-  Zadejte hodnotu MTU, jen když ji požaduje váš ISP. Jinak 
ponechejte výchozí nastavení. 

Auto-reconnect-  Automatická obnova připojení. Zvolte Enabled (povoleno) 
nebo Disabled (blokováno). 
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Použití konfiguračního menu (pokračování) 

 Home > WAN > Static IP Address 

 

Static IP Address-  
(Statická IP adresa) 

Zvolte Static IP Address, pokud máte od vašeho ISP přidě-
lenou pevnou IP adresu a všechny další parametry. Budete 
muset zadat IP adresu, masku podsítě, adresu brány a ad-
resu (adresy) DNS, které vám poskytl váš ISP. Všechny IP 
adresy zadané do polí musí mít správný formát, tj. čtyři sku-
piny oddělené tečkou (x.x.x.x). Směrovač nepřijme IP adre-
su, pokud nebude mít tento formát. 

IP Address- 
(IP adresa) 

Zadejte veřejnou IP adresu, kterou vám přidělil váš ISP.  
 

Subnet Mask-  
(Maska podsítě) 

Zadejte masku podsítě. (Všechna zařízení v síti musí mít 
stejnou masku podsítě.) 

ISP Gateway  
Address-  

Zadejte veřejnou adresu ISP, ke kterému se připojujete.  
 

Primary DNS  
Address-  

Zadejte IP adresu primárního DNS (Domain Name Server), 
kterou vám sdělil váš ISP. 

Secondary DNS 
Address-  

Adresa sekundárního DNS serveru.Tento parametr je voli-
telný. 

MTU-  Zadejte hodnotu MTU, jen když ji požaduje váš ISP. Jinak 
ponechejte výchozí nastavení. 
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Použití konfiguračního menu (pokračování) 

 

Pokud váš ISP použí-
vá spojení s protoko-
lem PPPoE (Point to 
Point Protocol over 
Ethernet), zvolte  
PPPoE. Váš ISP vám 
určí uživatelské jméno 
a heslo. Tato volba se 
používá obvykle 
u služeb DSL. Zvolte 
Dynamic PPPoE pro 
automatické získání 
IP adresy pro vaše 
PPPoE připojení. 
Zvolte Static PPPoE 
pro použití statické IP 
adresy pro vaše  
PPPoE připojení.  

Home > WAN > PPPoE 

 

PPPoE-  Vyberte tuto možnost, pokud váš ISP používá PPPoE. (Tuto 
volbu nastavují většinou uživatelé DSL.) 

Dynamic PPPoE: IP adresu získáváte automaticky od ISP. 

Static PPPoE: Máte přidělenou (statickou) IP adresu.  

User Name-  Vaše PPPoE uživatelské jméno určené vaším ISP. 

Retype 
Password- 

Opětovné zadání PPPoE hesla.   
 

Service Name-  Zadejte jméno služby určené vaším ISP (volitelné).  

IP Address-  Tato volba se používá jen pro statický PPPoE. Zadejte sta-
tickou IP adresu PPPoE připojení.  

Primary DNS  
Address-  

IP adresa primárního DNS určená vaším ISP.  
 

Secondary DNS  
Address-  

Tato volba se používá jen pro statický PPPoE. Zadejte sta-
tickou IP adresu PPPoE spojení.  

(Pokračování na další straně) 

 Před konfigu- 
 rací odstraňte 
z počítačů všechny 
nainstalované 
klientské programy 
PPPoE. 
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Použití konfiguračního menu (pokračování) 

Home > WAN > PPPoE pokračování 

MTU-  Maximum Transmission Unit – Výchozí nastavení je 1492. 
Můžete je změnit 

Auto-reconnect-  Je-li tato funkce zapnuta (Enabled) 

 Home > LAN 

 

LAN je zkratka pro lokální (místní) počítačovou síť. Tím je myšlena vaše interní síť. 
V tomto okně jsou nastavení IP rozhraní LAN pro DI-524. Tato nastavení lze ozna-
čit jako privátní nastavení. V případě potřeby můžete LAN IP adresu změnit. LAN 
IP adresa je ve vaší interní síti privátní a není ze strany Internetu vidět . 

IP Address-  IP adresa LAN rozhraní. Výchozí IP adresa je 192.168.0.1 
 

Subnet Mask-  Maska podsítě LAN rozhraní. Výchozí maska podsítě je 
255.255.255.0 

Local Domain-
Name-  

Toto pole je nepovinné. Zadejte název lokální domény.  
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Použití konfiguračního menu (pokračování) 

 Home > DHCP 

 

DHCP znamená Dynamic Host Control Protocol. DI-524 má zabudovaný server 
DHCP. Server DHCP bude automaticky přidělovat IP adresy počítačům 
v LAN/privátní síti. Nastavte počítače v síti tak, aby byly klienty DHCP. To zajistíte 
nastavením TCP/IP na „Získat adresu IP ze serveru DHCP automaticky“ (Obtain an 
IP Address Automatically). Když počítače zapnete, získají automaticky správné na-
stavení TCP/IP z DI-524. Server DHCP bude žádajícímu počítači automaticky přidě-
lovat nepoužívanou IP adresu z intervalu IP adres. Musíte zadat počáteční a konco-
vou adresu intervalu IP adres. 

DHCP Server-  Zvolte Enabled (zapnuto) nebo Disabled (vypnuto). Výchozí 
nastavení je Enabled. 

Starting IP 
Address-  

Počáteční adresa pro přidělení serverem DHCP. 

Ending IP 
Address- 

Koncová adresa pro přidělení serverem DHCP. 

Lease Time-  Doba přidělení IP adresy. Zadejte dobu, po kterou bude ad-
resa přidělena (zapůjčena). Výchozí nastavení je 1 hodina. 
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Použití konfiguračního menu (pokračování) 

 Advanced > Virtual Server 

 

DI-524 lze nakonfigurovat jako virtuální server tak, aby vzdálení uživatelé přistupující 
k webovým nebo FTP službám přes veřejnou IP adresu mohli být automaticky pře-
směrováni na lokální servery v LAN (Local Area Network).  

Firewall DI-524 filtruje nerozpoznané pakety, aby ochránil vaši LAN, takže všechny 
počítače připojené přes DI-524 jsou pro vnější svět neviditelné. Pokud chcete, může-
te některé počítače v síti LAN zpřístupnit přes Internetu pomocí Virtuálního serveru. 
V závislosti na požadované službě přesměruje DI-524 externí požadavek na službu 
na příslušný server v síti LAN. 

Směrovač DI-524 je schopen také přesměrovávat porty, což znamená, že příchozí 
požadavek na určitý port lze přesměrovat na jiný port na serverovém počítači. 

Každé vytvořená virtuální služba bude vypsána v dolní části okna v seznamu Virtual 
Servers List. V seznamu jsou již uvedeny předdefinované virtuální služby. Můžete je 
použít, když je aktivujete a přiřadíte IP serveru pro použití konkrétní virtuální služby. 
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Použití konfiguračního menu (pokračování) 

Advanced > Virtual Server pokračování 

Virtual Server-  Zvolte Enabled (zapnuto) nebo Disabled (vypnuto). 

Name-  Zadejte název označující virtuální službu. 

Private IP- Serverový počítač v LAN (Local Area Network), který bude 
poskytovat virtuální služby. 

Protocol Type-  Protokol používaný pro virtuální službu. 

Private Port-  Číslo portu služby používaného serverovým počítačem. 

Public Port-  Číslo portu na straně WAN (Wide Area Network), který bude 
používán pro přístup k virtuální službě. 

Schedule-  Časový rozvrh aktivace virtuální služby. Rozvrh může být 
nastaven na Always (Stále), což umožní, aby byla konkrétní 
služba stále aktivní. Při volbě Time (Čas) se nastavuje časo-
vý úsek, kdy má být služba aktivní. Je-li systémový čas mimo 
naplánovanou dobu, bude služba vypnuta. 

 

 

 

Příklad 1:  Máte-li webový server a chcete, aby k němu měli uživatelé 
Internetu stálý přístup, musíte jej aktivovat. Webový (HTTP) 
server je na LAN počítači s IP 192.168.0.25, HTTP používá 
port 80, TCP. 

Name: Web Server 
Private IP: 192.168.0.25 
Protocol Type: TCP 
Private Port: 80 
Public Port: 80 
Schedule: always 
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Použití konfiguračního menu (pokračování) 

Advanced > Virtual Server pokračování 

 

 

Klikněte na tuto ikonu pro editaci virtuální služby. 

Klikněte na tuto ikonu pro odstranění virtuální služby. 

 
 

Příklad 2: 
Máte-li FTP server, který chcete zpřístupnit uživatelům Internetu přes WAN port 
2100 a pouze o víkendech, měli byste jej aktivovat následujícím způsobem. FTP 
server je na LAN počítači s adresou 192.168.0.30. FTP používá port 21, TCP. 

Name: FTP Server 
Private IP: 192.168.0.30 
Protocol Type: TCP 
Private Port: 21 
Public Port: 2100 
Schedule: From: 01:00AM to 01:00AM, Sat to Sun 

Všichni uživatelé Internetu, kteří chtějí mít přístup k tomuto serveru, se k němu musí 
připojovat přes port 2100. Tento příklad ukazuje přesměrování portu, které může být 
užitečné v případech, kdy je v síti LAN mnoho stejných serverů. 
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Použití konfiguračního menu (pokračování) 

Advanced > Applications 

 

Některé aplikace, např. internetové hry, videokonference, telefonování přes internet 
apod., vyžadují vícenásobné spojení. Tyto aplikace mají potíže při práci přes NAT 
(Network Address Translation). Menu Special Applications umožňuje některým 
z těchto aplikací pracovat s DI-524. Potřebujete-li provozovat aplikaci, která vyžadu-
je vícenásobné spojení, zadejte v poli Trigger port (Spouštěcí port) port, který apli-
kace normálně používá, nastavte typ protokolu, např. TCP nebo UDP, a pak zadejte 
veřejné porty, spojené se spouštěcím portem, abyste je otevřeli pro příchozí provoz. 

DI-524 nabízí v tabulce dole na stránce několik předdefinovaných aplikací. Vyberte 
aplikaci, kterou chcete používat, a aktivujte ji. 

Pozor! Každý z tunelů speciální aplikace může být používán jen jedním počítačem. 

Name:  Název označující speciální aplikaci. 

Trigger Port:  Tento port se používá pro spuštění aplikace. Může to být jeden 
port nebo interval portů. 

Trigger Type:  Tento protokol se používá pro spuštění speciální aplikace. 

Public Port:  Číslo portu na straně WAN, který bude použit pro přístup 
k aplikaci. Můžete definovat jeden port nebo interval portů. Pro 
přidání dalších portů nebo intervalů portů použijte čárku. 

Public Type:  Tento protokol se používá pro speciální aplikaci. 
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Použití konfiguračního menu (pokračování) 

Advanced > Filters > IP Filters 

 

Filtry se používají k tomu, aby zablokovaly nebo povolily počítačům v LAN přístup 
k Internetu. DI-524 lze nastavit tak, aby blokoval interní počítače podle jejich IP nebo 
MAC adres. DI-524 může také blokovat přístup uživatelů na zakázané webové 
stránky. 

IP Filters: Použijte pro zablokování přístupu z LAN IP adresy k Internetu. 
Můžete zablokovat určitá čísla portu nebo všechny porty určité 
IP adresy. 

IP Address:  IP adresa počítače v LAN, které bude zablokován přístup 
k Internetu. 

Port Range:  Jeden port nebo interval portů, kterým bude zablokován pří-
stup k Internetu. 

Protocol Type:  Nastavte typ protokolu. 

Schedule:  Časový rozvrh, kdy bude IP filtr zapnut. 
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Použití konfiguračního menu (pokračování) 

Advanced > Filters > URL Blocking 

 

Blokování URL se používá pro zablokování přístupu počítačů v LAN k určitým webo-
vým stránkám podle jejich URL. URL je textový řetězec se speciálním formátem, 
který definuje místo (adresu stránky) na Internetu. Pokud některá část URL obsahuje 
blokovaná slova, nebudou stránky přístupné a nezobrazí se. Pro použití této funkce 
zadejte textový řetězec, který se má blokovat a klikněte na Apply (Použít). Blokova-
ný text se objeví v seznamu. Chcete-li text odstranit, vyberte jej a klikněte na Delete 
(Odstranit). 

Filters-  Vyberte filtr, který chcete použít. V tomto případě bylo zvoleno  
URL Blocking (Blokování URL). 

URL Blocking-  Zvolte Enabled (blokování URL zapnuto) nebo Disabled (blo-
kování URL vypnuto). 

Keywords-  Do tohoto pole zadejte klíčová slova. Blokují se URL adresy, 
které obsahují zadaná klíčová slova. 
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Použití konfiguračního menu (pokračování) 

Advanced > Filters > MAC Filters 

 

Použijte MAC (Media Access Control) filtr pro povolení nebo blokování přístupu po-
čítačů v LAN (Local Area Network) k síti podle jejich MAC adres. MAC adresu může-
te zadat ručně nebo ji vybrat ze seznamu klientů, kteří jsou právě připojeni k široko-
pásmovému směrovači. 

Filters-  Vyberte filtr, který chcete použít. V tomto případě bylo zvoleno 
MAC filters (Filtrování MAC adres). 

MAC Filters-   Zvolte Disable MAC filter pro vypnutí MAC filtru, allow pro 
povolení přístupu jen pro zadané MAC adresy nebo deny pro 
zablokování přístupu jen pro vybrané MAC adresy. 

Name-  Zde zadejte název filtru. 

MAC Address-  Zadejte MAC adresu. 

DHCP Client-  Pro zkopírování MAC adresy vyberte z rozvinovacího sezna-
mu klienta DHCP a klikněte na Clone (Klonovat). 
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Použití konfiguračního menu (pokračování) 

Advanced > Filters > Domain Blocking 

 

Blokování domén se používá pro povolení nebo zablokování přístupu počítačů 
v LAN (Local Area Network) k určitým doménám na Internetu. Blokování domény 
zablokuje všechny požadavky na přístup k zadané doméně, např. http a ftp. Umož-
ňuje také povolit počítačům přístup k určitým doménám a zablokovat všechny ostat-
ní stránky. 

Filters-  Vyberte filtr, který chcete použít. Zde bylo vybráno Doma-
in Blocking (Blokování domén). 

Domain Blocking- (Blokování domén) 

Disabled-  Zvolte Disabled, pokud chcete blokování domén vypnout. 

Allow-  Umožňuje přístup ke všem doménám s výjimkou blokova-
ných domén (Blocked Domains). 

Deny-  Blokuje přístup ke všem doménám s výjimkou povolených 
domén (Permitted Domains). 

Permitted Domains-  Do tohoto pole zadejte povolené domény. 

Blocked Domains-  Do tohoto pole zadejte blokované domény. 
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Použití konfiguračního menu (pokračování) 

Advanced > Firewall  

 

Firewall Rules (Pravidla firewallu) je funkce používaná pro zablokování nebo povo-
lení provozu přes DI-524. Pracuje stejným způsobem jako IP filtry s dodatečným 
nastavením. Můžete vytvořit podrobnější pravidla provozu s DI-524. Jsou-li vytvoře-
ny a povoleny virtuální služby, zobrazí se také v pravidlech firewallu. Seznam Fire-
wall Rules obsahuje všechna pravidla firewallu, která patří k IP (Internet Protocol).  

V seznamu pravidel Firewall Rules List v dolní části okna jsou priority pravidel brány 
shora (nejvyšší priorita) dolů (nejnižší priorita). 

Poznámka:  
Pravidla filtrování MAC adres na DI-524 mají přednost před pravidly firewallu. 

Firewall Rules-  Enable (Zapnutí) nebo Disable (Vypnutí) firewallu. 

Name-  Zadejte název pravidla. 

Action-  Akce: Allow (Povoleno) nebo Deny (Blokováno). 

Source-  
(Zdroj) 

Zadejte interval IP adres (IP Range Start – IP Range End). 

Destination-  
(Cíl) 

Zadejte interval IP adres (IP Range Start – IP Range End), 
protokol (Protocol) a interval čísel portu (Port Range). 

Schedule-  
(Rozvrh) 

Zvolte Always (Vždy) nebo zadejte časový rozvrh. 
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Použití konfiguračního menu (pokračování) 

Advanced > DDNS 

 

Uživatelé, kteří využívají služeb dynamického DNS serveru, mohou použít tuto funk-
ci DI-524. 

Provider- Vyberte poskytovatele ze seznamu dostupných DDNS serve-
rů. 

Host Name-  Zadejte hostitelské jméno svého DDNS účtu. 

Username/Email-  Zadejte jméno uživatele svého DDNS účtu. 

Password/Key-  Zadejte heslo svého DDNS účtu. 
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Použití konfiguračního menu (pokračování) 

Advanced > DMZ 

 

Máte-li klientský PC, který nedokáže provozovat internetovou aplikaci zpoza DI-524, 
můžete pro klienta nastavit neomezený přístup k Internetu. Tím se počítač otevře 
přístupu z Internetu. Tato funkce se hodí např. pro hraní her. Zadejte IP adresu in-
terního počítače, který bude hostitelem DMZ (demilitarizované zóny). Přidání klienta 
do DMZ může vaši interní síť vystavit různým bezpečnostním rizikům, proto použí-
vejte tuto funkci jako poslední nouzovou možnost. 

DMZ- Enable (Zapnutí) nebo Disable (Vypnutí) DMZ. DMZ (Demilita-
rizovaná zóna) umožňuje „vystavit“ jeden počítač na Internetu. 
Při výchozím nastavení je DMZ vypnuta. 

IP Address-  Zadejte IP adresu počítače, který bude v DMZ. 
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Použití konfiguračního menu (pokračování) 

Advanced > Performance  

 

Beacon Interval-  Beacon jsou speciální pakety, které posílá přístupový bod pro 
synchronizaci bezdrátové sítě. Zadejte hodnotu. Doporučuje 
se výchozí hodnota 100. 

RTS Threshold-   Doporučuje se nechat výchozí nastavení 2432. Při potížích 
s konzistencí dat, měla by být provedena jen malá změna. 

Fragmentation-  Práh fragmentace udávaný v bytech určuje, zda budou pake-
ty fragmentovány. Pakety delší než tato hodnota budou před 
vysláním rozděleny. Výchozí nastavení je 2346. 

DTIM interval-  Výchozí nastavení DTIM (Delivery Traffic Indication 
Message) je 3. DTIM je odpočet informující klienty o dalším 
okně pro naslouchání vysílání a skupinové zprávy. 

Wireless Mode- Nastavuje Short Preamble (Krátké záhlaví) nebo Long Pre-
amble (Dlouhé záhlaví). Definuje délku CRC bloku (používá 
se pro detekci chyb při přenosu dat) pro komunikaci mezi 
bezdrátovým směrovačem a obsluhovanými bezdrátovými 
síťovými adaptéry. Poznámka: V sítích se silným provozem 
by se měla používat kratší délka záhlaví. 

TX Rates- Rychlost přenosu. Výchozí nastavení Auto (automatické na-
stavení). Vyberte rychlost z rozvinovacího menu. 

SSID Broadcast- Pro vysílání identifikace SSID v síti zvolte Enabled (Zapnuto). 
Pro navázání spojení musí všechna zařízení v síti sdílet stej-
nou identifikaci SSID (Service Set Identifier). Zvolte Disabled 
(Vypnuto), pokud nechcete SSID v síti vysílat. 



31 

Použití konfiguračního menu (pokračování) 

Tools> Admin 

 

Na této stránce může správce DI-524 změnit systémové heslo. Pro přístup k webo-
vému rozhraní širokopásmového směrovače slouží dva účty – admin (správce) a 
user (uživatel). Admin může číst i zapisovat, user pouze číst. Uživatelé mohou na-
stavení pouze prohlížet, ale nemohou provádět žádné změny. 

Administrator-  Přihlašovací jméno správce je admin. 

Password-  Zadejte heslo a pak je zadejte znovu pro kontrolu. 

User-  Přihlašovací jméno uživatele je user. 

Password-  Zadejte heslo a pak je zadejte znovu pro kontrolu. 

Remote Management- Vzdálená správa umožňuje konfigurovat DI-524 webovým 

prohlížečem přes Internet. Pro přístup k webovému rozhraní je zapotřebí jméno uži-
vatele a heslo. Normálně může prohlížet zabudované webové stránky a měnit na-
stavení směrovače jen člen vaší sítě. Je-li tato funkce zapnuta (Enabled), umožňuje 
spravovat směrovač i ze vzdáleného (internetového) hostitele. 

IP Address- Internetová IP adresa počítače, který má přístup k širokopásmového 

směrovači. Zadáte-li do tohoto pole hvězdičku (*), může získat přístup ke směrovači 
libovolný počítač. Vložení hvězdičky (*) do tohoto pole představuje bezpečnostní 
riziko a nedoporučuje se.  

Port- Číslo portu použitého pro přístup ke směrovači. 

Příklad- http://x.x.x.x:8080 kde x.x.x.x je WAN IP adresa směrovače a  8080 je port 

použitý pro přístup k rozhraní webové správy. 
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Použití konfiguračního menu (pokračování) 

Tools > Time 

 

Default NTP 
Server-  

NTP je zkratka pro Network Time Protocol. NTP synchronizuje 
časy hodin počítačů v síti. Toto pole je nepovinné. 

Time Zone-  Z rozvinovacího menu vyberte časové pásmo. 

Set the Time-  Pro ruční zadání času zadejte do těchto polí hodnoty Year 
(Rok), Month (Měsíc), Day (Den), Hour (Hodina), Minute (Mi-
nuta) a Second (Sekunda). Klikněte na Set Time. 

Daylight  
Saving-  

Pro ruční nastavení období letního času zvolte Enabled (Za-
pnuto) nebo Disabled (Vypnuto) a zadejte počáteční (Start) a 
koncové (End) datum období letního času. 
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Použití konfiguračního menu (pokračování) 

Tools > System 

 

Aktuální nastavení systému lze uložit jako soubor na lokální pevný disk. Uložený 
soubor nebo libovolné další uložené soubory nastavení lze načíst zpět do směrova-
če. Pro opětovné načtení souboru nastavení systému klikněte na Browse (Prochá-
zet), abyste mohli prohlížet lokální pevný disk a najít systémový soubor, který se má 
použít. Kliknutím na Restore (Obnovit) můžete také obnovit výchozí tovární nasta-
vení směrovače. 

Save Settings to 
Local Hard Drive-  

Pro uložení aktuálního nastavení na lokální pevný disk 
klikněte na Save. 

Load Settings from 
Local Hard Drive-  

Pro nalezení nastavení klikněte na Browse a po nalezení 
souboru klikněte na Load (Načíst).¨ 

Restore to Factory 
Default Settings-  

Pro obnovení výchozího továrního nastavení klikněte na 
tlačítko Restore. 
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Použití konfiguračního menu (pokračování) 

Tools > Firmware 

 

Zde můžete aktualizovat firmware směrovače. Ujistěte se, že firmware, který chcete 
použít, je na lokálním disku počítače. Klikněte na Browse (Procházet), abyste mohli 
prohlížet lokální pevný disk a najít firmware pro aktualizaci. Aktuální firmware najde-
te na internetových stránkách technické podpory D-Link: http://support.dlink.com. 
Odtud si jej můžete stáhnout na váš pevný disk. 

Firmware Upgrade-  Klikněte na tento odkaz, abyste zjistili, zda je k dispozici 
aktualizovaný firmware. Pokud je, stáhněte jej na pevný 
disk. 

Browse-  Po stažení nového firmwaru klikněte v tomto okně na 
tlačítko Browse (Procházet), abyste mohli na pevném 
disku vyhledat soubor s aktualizovaným firmwarem. Do-
končete upgrade firmwaru kliknutím na Apply (Použít). 
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Použití konfiguračního menu (pokračování) 

Tools > Misc 

 

Ping Test-  Pingový test se používá pro odeslání pingových paketů, aby 
se např. zjistilo, zda je počítač na Internetu. Zadejte testova-
nou IP adresu a klikněte na Ping. 

Restart Device-  Pro restartování DI-524 klikněte na Reboot. 

Block WAN 
Ping-  

Zapnete-li blokování WAN pingů, nebude WAN IP adresa DI-
524 odpovídat na pingy. Blokování může zvýšit ochranu proti 
hackerům. Pro zapnutí blokování pingů ze strany WAN klikně-
te na Enable. 

UPNP- Pro použití funkce Universal Plug and Play klikněte na Ena-
bled. UPNP zajišťuje kompatibilitu se síťovými zařízeními, 
softwarem a periferiemi více než 400 výrobců, kteří spolupra-
cují na fóru Plug and Play. 

VPN 
Pass 
Through- 

DI-524 podporuje VPN (Virtual Private Network) přenos pro 
PPTP (Point-to-Point Tunneling Protocol) a IPSec (IP Securi-
ty). Je-li VPN přenos zapnut, není zapotřebí otevírat virtuální 
zařízení. Přes DI-624+ lze vytvořit mnoho VPN spojení. Je to 
užitečné, pokud máte v síti LAN mnoho VPN klientů. 

PPTP- Zvolte Enabled (Zapnuto) nebo Disabled (Vypnuto). 
IPSec- Zvolte Enabled (Zapnuto) nebo Disabled (Vypnuto). 
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Použití konfiguračního menu (pokračování) 

Status > Device Info 

 

Tato stránka zobrazuje aktuální informace o DI-524. Jsou zde informace o LAN, 
WAN a MAC adresách. 
Je-li vaše připojení k WAN nastaveno na Dynamic IP address (Dynamická IP adre-
sa), zobrazí se tlačítka Release (Odpojit) a Renew (Obnovit). Tlačítko Release pou-
žijte pro odpojení od ISP a tlačítko Renew pro připojení k ISP.  
Je-li vaše připojení k WAN nastaveno na PPPoE, zobrazí se tlačítka Connect (Při-
pojit) a Disconnect (Odpojit). Tlačítko Disconnect použijte pro ukončení PPPoE 
spojení a tlačítko Connect pro navázání PPPoE spojení. 
Okno ukazuje následující provozní stavy DI-524: 

WAN IP Address: WAN/veřejná IP adresa 
Subnet Mask: WAN/veřejná maska podsítě 
Gateway: WAN/veřejná IP adresa brány 
Domain Name Server: WAN/veřejná IP adresa DNS 
WAN Status: Stav připojení k WAN 

LAN IP Address: LAN/privátní IP adresa DI-524 
Subnet Mask: LAN/privátní maska podsítě DI-524 

Wireless MAC Address: Zobrazuje MAC adresu 
SSID: Zobrazuje aktuální SSID 
Channel: Zobrazuje aktuální kanál 
WEP: Indikuje, zda je zapnuto nebo vypnuto šifrování WEP 
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Použití konfiguračního menu (pokračování) 

Status > Log 

 

Směrovač si vytváří průběžný deník událostí a aktivit, která nastávají na směrovači. 
Při restartování zařízení se tyto záznamy automaticky odstraní. Záznamy můžete 
uložit pomocí Log Settings. 

View Log- First Page - První strana deníku 
Last Page - Poslední strana deníku 
Previous - Posun o jednu stranu vzad 
Next - Posun o jednu stranu vpřed 
Clear - Odstranění všech záznamů z deníku 
Log Settings - Vyvolání stránky pro konfiguraci deníku. 
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Použití konfiguračního menu (pokračování) 

Status > Log > Log Settings 

 

Směrovač záznamy o aktivitách a událostech nejen zobrazuje, ale může je také 
odesílat na jiné místo. 

SMTP Server/IP 
Address - 

Adresa SMTP serveru, který bude použit pro odeslání zá-
znamů. 

Email Address - E-mailová adresa, na kterou budou záznamy odeslány. Klik-
něte na Send Mail Now, abyste odeslali e-mail. 
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Použití konfiguračního menu (pokračování) 

Status > Stats 

 

Výše uvedené okno zobrazuje statistiky provozu. Můžete zde vidět počet paketů, 
které prochází přes WAN i LAN porty na DI-524. Počitadlo provozu se vynuluje, když 
je směrovač restartován. 

Status > Wireless 

 

Tabulka bezdrátových klientů ukazuje seznam aktuálně připojených klientů bezdrá-
tové sítě. Zobrazuje také čas připojení a MAC adresu bezdrátového klienta. 
Další informace získáte kdykoli kliknutím na Help (Nápověda).  
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Základy síťového provozu 

Použití Průvodce instalací sítě ve Windows XP 

 
V této části se naučíte, vytvořit síť doma nebo v kanceláři v prostředí Microsoft 
Windows XP. 

Poznámka: Informace o vytvoření sítě v prostředí Windows 2000, ME nebo 98  
najdete například na http://www.homenethelp.com 

a http://www.microsoft.com/windows2000. 
 
Jděte na Start > Ovládací panely (Control Panel) > Síťová připojení (Network 
Connections).  

Zvolte Nastavit síť pro domácnost nebo malou kancelář (Set up a home or small 
office network). 

 

Když se objeví toto okno, klikněte na Další (Next). 

http://www.homenethelp.com/
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Základy síťového provozu 

Proveďte všechny pokyny v tomto okně. 

 

Klikněte na Další (Next).  

V následujícím okně vyberte popis, který nejlépe odpovídá vašemu počítači. Je-li 
počítač připojen k Internetu přes bránu/směrovač, vyberte druhou možnost. 

 

Klikněte na Další (Next). 
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Základy síťového provozu 

Zadejte Popis počítače (Computer description) a Název počítače (Computer na-
me) (volitelné). 

 

Klikněte na Další (Next). 

Zadejte Název pracovní skupiny (Workgroup name). Všechny počítače ve vaší síti 
by měly mít stejný název pracovní skupiny. 

 

Klikněte na Další (Next). 
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Základy síťového provozu 

Počkejte, dokud Průvodce instalací sítě neprovede změny. 

 

Po dokončení změn klikněte na Další (Next).  

Počkejte, dokud Průvodce instalací sítě nenakonfiguruje počítač. Může to trvat 
i několik minut. 
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Základy síťového provozu  

V níže uvedeném okně vyberte možnost, která vám nejlépe vyhovuje. V příkladu je 
vybráno Vytvořit síťovou instalační disketu (Create a Network Setup Disk). Tuto 
disketu spustíte na každém počítači ve vaší síti. Klikněte na Další (Next). 

 

Vložte disketu do disketové jednotky, v tomto případě do mechaniky A. 

 

Klikněte na Další (Next). 
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Základy síťového provozu  

 

Přečtěte si pokyny, uvedené v okně níže. Po ukončení Průvodce instalací sítě pou-
žijte síťovou instalační disketu pro spuštění Průvodce instalací sítě jednou na všech 
počítačích v síti. Pokračujte kliknutím na Další (Next).  
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Základy síťového provozu  

Přečtěte si pokyny v tomto okně a pak klikněte na Dokončit (Finish), abyste ukončili 
Průvodce instalací sítě. 

 

Nové nastavení se uplatní po restartování počítače. Restartujte počítač kliknutím na 
Ano (Yes). 

 

Tím jste dokončili konfiguraci tohoto počítače. Pak budete muset spustit disketu pro 
instalaci sítě na všech ostatních počítačích v síti. Po spuštění této diskety na všech 
počítačích bude nová bezdrátová síť připravena k použití. 
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Základy síťového provozu  

Pojmenování počítače  

Chcete-li počítač pojmenovat, postupujte podle těchto pokynů:  

Ve Windows XP:  

 Klikněte na Start. 
 Klikněte pravým tlačítkem na Tento počítač (My Computer). 
 Vyberte Vlastnosti (Properties) a klikněte. 

 
 
 V okně Vlastnosti sys-

tému (System Proper-
ties) vyberte záložku 
Název počítače (Com-
puter Name).  

 
 Pokud chcete, můžete 

zadat volitelný Popis 
počítače (Computer 
description). 

 
 Pro přejmenování počí-

tače nebo připojení 
k doméně klikněte na 
Změnit (Change). 
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Základy síťového provozu  

Pojmenování počítače 

 V tomto okně zadejte Název 
počítače (Computer name).  

 
 Vyberte Je členem Pracovní 

skupiny (Workgroup) a zadejte 
název pracovní skupiny.  

 
 Všechny počítače ve vaší síti 

musí mít stejný název pracovní 
skupiny.  

 
 Klikněte na OK.  

 

 

Zjištění IP adresy ve Windows XP 

Počítače ve vaší síti, které jsou vybaveny bezdrátovým adaptérem, musí mít IP ad-
resu ze stejného intervalu (definice intervalu IP adres viz část „Začínáme” v tomto 
návodu). Při kontrole IP adresy adaptéru postupujte takto: 

 Klikněte pravým tla-
čítkem na ikonu Při-
pojení k místní síti 
(Local Area Con-
nection) na hlavním 
panelu. 

 
 Klikněte na Stav (Sta-

tus).  
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Základy síťového provozu  

Zjištění IP adresy ve Windows XP 

Objeví se následující okno. 
 

 Klikněte na záložku 
Podpora (Support). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Klikněte na Zavřít (Clo-
se).  

Přiřazení statické IP adresy ve Windows XP/2000 

Poznámka: Rezidentní brány/širokopásmové směrovače přiřazují počítačům v síti IP 
adresy automaticky pomocí funkce DHCP (Dynamic Host Configuration Protocol). 
Používáte-li bránu/směrovač s funkcí DHCP, nepotřebujete přiřazovat statické IP 
adresy.  

Pokud nepoužíváte bránu/směrovač s funkcí DHCP nebo potřebujete přiřadit static-
kou IP adresu, postupujte takto:  

 
 Jděte na Start.  
 
 
 
 Klikněte dvojitě na 

Ovládací panely 
(Control Panel). 
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Základy síťového provozu  

Přiřazení statické IP adresy ve Windows XP/2000 

 
 
 
 
 

 Klikněte dvojitě na Síťová připojení 
(Network Connections).  

 
 

 

 
 
 
 
 
 
 

 Klikněte pravým tlačítkem na Připo-
jení k místní síti (Local Area Con-
nections).  

 
 

 Klikněte na Vlastnosti (Properties). 
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Základy síťového provozu  

Přiřazení statické IP adresy ve Windows XP/2000 

Vyberte Protokol sítě Internet (Inter-
net Protocol) (TCP/IP). 
 

 Klikněte na Vlastnosti (Proper-
ties). 

 
 

 Zadejte vaši IP adresu a masku 
podsítě. (IP adresy ve vaší síti 
musí být ze stejného intervalu. 
Má-li například jeden počítač IP 
adresu 192.168.0.2, měly by mít 
další počítače následující adresy, 
například 192.168.0.3 a 
192.168.0.4. Maska podsítě musí 
být u všech počítačů v síti stej-
ná.)  

 
 
 
 
 
 
 
 
 

 Zadejte adresy vašeho DNS 
serveru. (Poznámka: Přistupuje-
te-li na DNS server, musíte zadat 
IP adresu Výchozí brány (Default 
Gateway).  

 
 
Informace o DNS serveru získáte 
u svého poskytovatele připojení k Inter-
netu (ISP). 
 

 Klikněte na OK. 
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Základy síťového provozu  

Přiřazení statické IP adresy Macintosh OSX 

 
 

 Jděte na Apple Menu a zvolte System 
Preferences. 

 
 Klikněte na Network. 

 
 

 

 
 

 V rozvinovacím menu Show vy-
berte Built-in Ethernet. 

 
 V rozvinovacím menu Configure 

zvolte Manually. 
 

 

 
 
 
 

 Zadejte do příslušných polí sta-
tickou IP adresu (IP Address), 
masku podsítě (Subnet Mask) a 
IP adresu směrovače (Router). 

 
 
 
 
 

 Klikněte na Apply Now. 
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Základy síťového provozu  

Nastavení dynamické IP adresy v Macintosh OSX 

 

 
 

 Jděte na Apple Menu a zvolte System 
Preferences. 

 
 Klikněte na Network. 

 
 

 

 
 

 V rozvinovacím menu Show vy-
berte Built-in Ethernet. 

 
 V rozvinovacím menu Configure 

zvolte Using DHCP. 
 
 

 

 
 
 
 

 Klikněte na Apply Now. 
 

 Během několika sekund se objeví 
IP adresa (IP Address), maska 
podsítě (Subnet Mask) a IP ad-
resa směrovače (Router). 
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Základy síťového provozu  

Kontrola bezdrátového spojení pomocí příkazu ping ve Windows 
XP/2000 

 Jděte na Start > Spustit 
(Run) > napište cmd. 
Objeví se okno, podobné 
tomu, které vidíte na ob-
rázku. Napište: 
ping xxx.xxx.xxx.xxx, 
kde xxx je IP adresa 
bezdrátového směrova-
če nebo přístupového 
bodu. Při dobrém bez-
drátovém spojení se 
zobrazí čtyři odezvy 
z bezdrátového směro-
vače nebo přístupového 
bodu, jak je vidět na ob-
rázku.  

 

 

Kontrola bezdrátového spojení pomocí příkazu ping ve Windows 
ME/98 

 Jděte na Start > Spustit 
(Run) > napište  
command. Objeví se 
okno, podobné tomu, 
které vidíte na obrázku. 
Napište: 
ping xxx.xxx.xxx.xxx, 
kde xxx je IP adresa 
bezdrátového směrova-
če nebo přístupového 
bodu. Při dobrém bez-
drátovém spojení se 
zobrazí čtyři odezvy 
z bezdrátového směro-
vače nebo přístupového 
bodu, jak je vidět na ob-
rázku.  
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Řešení potíží 
Tato kapitola obsahuje řešení problémů, které mohou nastat při instalaci a provozu 
bezdrátového širokopásmového směrovače DI-524. Pokrývá různé stránky nastave-
ní sítě včetně síťových adaptérů. Máte-li nějaké potíže, přečtěte si následující části. 

Poznámka: Pro konfiguraci bezdrátového širokopásmového směrovače  
DI-524 se doporučuje použít ethernetové připojení. 

 

1. Počítač použitý pro konfiguraci DI-524 nemůže vyvolat konfigu-
rační menu.  

  Zkontrolujte, zda indikátor ethernetového připojení na DI-524 svítí. Pokud 
indikátor nesvítí, zkontrolujte, zda je ethernetový kabel správně připojen.  

  Zkontrolujte, zda ethernetový adaptér pracuje správně. Podle bodu 3 v této 
části (Zkontrolujte, zda jsou ovladače pro síťové adaptéry správně nainstalo-
vány) zkontrolujte, zda jsou správně nainstalovány ovladače.  

  Zkontrolujte, zda je IP adresa ve stejném intervalu a podsíti jako DI-524. Viz 
část Zjištění IP adresy ve Windows XP v kapitole Základy síťového provozu 
v tomto návodu.  

Poznámka: IP adresa DI-524 je 192.168.0.1. Všechny počítače v síti musí mít 
jedinečnou IP adresu ve stejném intervalu, tj. 192.168.0.x. a masku podsítě 
255.255.255.0. Počítače, které mají stejné IP adresy, nebudou v síti viditelné.  

  Udělejte pingový test, abyste zjistili, zda DI-524 odpovídá. Jděte na Start > 
Spustit (Run) > napište command >napište ping 192.168.0.1. Úspěšný ping 
zobrazí čtyři odezvy.  

 

Poznámka: Pokud jste výchozí 
IP adresu směrovače změnili, 
použijte pro kontrolu pingu 
aktuální IP adresu DI-524. 
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Řešení potíží 

2. Bezdrátový klient se nemůže dostat v infrastrukturním režimu 
na Internet.  

Zkontrolujte, zda je bezdrátový klient přiřazen a připojen ke správnému přístupo-
vému bodu. Postup kontroly: Klikněte pravým tlačítkem na ikonu připojení 
k bezdrátové síti na hlavním panelu > zvolte Zobrazit bezdrátové sítě 
k dispozici (View Available Wireless Networks). Objeví se okno Připojit 
k bezdrátové síti (Connect to Wireless Network). Zkontrolujte, zda jste zvolili 
správnou dostupnou síť, jak ukazuje obrázek níže. 

 

 

 Zkontrolujte, zda je IP adresa přiřazena k bezdrátovému adaptéru se stejným 
intervalem IP adres jako přístupový bod nebo brána. (Jelikož DI-524 má IP 
adresu 192.168.0.1, musí mít bezdrátové adaptéry IP adresu ve stejném in-
tervalu, tj. 192.168.0.x. Každé zařízení musí mít jedinečnou IP adresu; žádná 
dvě zařízení nesmí mít stejnou IP adresu. Maska podsítě musí být pro všech-
ny počítače v síti stejná.) Pro kontrolu IP adresy přiřazené bezdrátovému 
adaptéru klikněte dvojitě na ikonu připojení k bezdrátové síti na hlavním pa-
nelu > vyberte záložku Upřesnit (Support) a zobrazí se IP adresa. (Viz Zjiště-
ní IP adresy v kapitole Základy síťového provozu v tomto návodu.)  

  Je-li zapotřebí přiřadit bezdrátovému adaptéru statickou IP adresu, podívejte 
se na odpovídající popis v kapitole Základy síťového provozu. Zadáváte-li 
adresu DNS serveru, (DNS Server Address), musíte zadat také adresu vý-
chozí brány (Default Gateway Address). (Pamatujte, že když máte směrovač 
s funkcí DHCP, nemusíte přiřazovat statické IP adresy. Viz Základy síťového 
provozu: Přiřazení statické IP adresy.)  
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Řešení potíží 

3. Zkontrolujte, zda jsou správně nainstalovány ovladače pro sí-
ťové adaptéry.  

Můžete používat jiné síťové adaptéry, než jsou zde ukázány, ale tento postup zů-
stává stejný bez ohledu na typ použitých adaptérů. 

 Jděte na Start > Tento 
počítač (My Computer) > 
Vlastnosti (Properties). 

 

 
 Vyberte záložku Hardwa-

re. 

 
 
 
 
 
 
 
 

 Klikněte na Správce zaří-
zení (Device Manager). 
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  Klikněte dvojitě na Síťové 

adaptéry (Network Adapters). 

 
 
 
 
 

  Klikněte pravým tlačítkem na 
D-Link AirPlus DWL-G650 
Wireless Cardbus Adapter. 
(V tomto příkladu se používá 
DWL-G650; můžete použít i ji-
né síťové adaptéry, ale postup 
zůstane stejný.) 

 
 
 
 
 

  Zvolte Vlastnosti (Properties) 
abyste zjistili, zda jsou ovlada-
če správně nainstalovány. 

 
 
 
 
 

  Podívejte se na Stav zařízení 
(Device Status), abyste zkon-
trolovali, zda zařízení pracuje 
správně.  

 
  Klikněte na OK.  
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4. Co může způsobit, že dojde ke ztrátě spojení? 

Výrobky D-Link umožňují přístup k síti téměř odkudkoli. Dosah bezdrátové spoje-
ní je však ovlivněn jejich umístěním v daném prostředí. Další informace o nej-
vhodnějším umístění bezdrátových zařízení D-Link najdete v části Podmínky pro 
instalaci v kapitole Základy bezdrátového provozu. 

 

5. Proč bezdrátové spojení stále vypadává? 

  Orientace antény – Zkuste nasměrovat anténu DI-524 jinak. Mějte anténu ale-
spoň 15 cm od jiných předmětů. 

  Používáte-li bezdrátový telefon, pracující v pásmu 2,4 GHz, zařízení X-10 ne-
bo jiné domovní zabezpečovací systémy, stropní ventilátory a svítidla, může 
se spojení výrazně zhoršit nebo úplně vypadnout. Abyste zamezili rušení, 
zkuste změnit kanál na směrovači, přístupovém bodu a bezdrátových adapté-
rech. 

  Umístěte zařízení nejméně 1–2 metry od elektrických zařízení, která vyzařují 
elektromagnetické vlny, např. mikrovlnné trouby, monitory, elektrické motory 
atd. 

 

6. Proč bezdrátové spojení nefunguje? 

Pokud jste na DI-524 zapnuli šifrování, musíte je zapnout také na všech bezdrá-
tových klientech, aby bylo možné navázat bezdrátové spojení. 

  Pro 802.11b lze nastavit 64, 128 nebo 256bitové šifrování. Zkontrolujte, zda je 
úroveň šifrování na směrovači a bezdrátovém klientovi stejná. 

  Zkontrolujte, zda je SSID na směrovači a bezdrátovém klientovi přesně stejné. 
Pokud není, nelze spojení navázat. 

  Umístěte DI-524 a bezdrátového klienta do stejné místnosti a otestujte bez-
drátové spojení. 

  Vypněte všechny bezpečnostní funkce (WEP, kontrola MAC adresy). 
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6. Proč bezdrátové spojení nefunguje? (pokračování) 

  Vypněte DI-524 a klienta. Zapněte znovu DI-524 a pak zapněte klienta. 

  Zkontrolujte, zda jsou všechna zařízení nastavena do Infrastrukturního reži-
mu. 

  Zkontrolujte, zda indikátory indikují normální činnost. Pokud ne, zkontrolujte, 
zda je připojeno napájení a zda jsou správně připojeny ethernetové kabely. 

  Zkontrolujte, zda je pro síť správně nastavena IP adresa, maska podsítě, brá-
na a DNS. 

  Používáte-li bezdrátový telefon, pracující v pásmu 2,4 GHz, zařízení X-10 ne-
bo jiné domovní zabezpečovací systémy, stropní ventilátory a svítidla, může 
se spojení výrazně zhoršit nebo úplně vypadnout. Abyste zamezili rušení, 
zkuste změnit kanál na směrovači, přístupovém bodu a bezdrátových adapté-
rech. 

  Umístěte zařízení nejméně 1–2 metry od elektrických zařízení, která vyzařují 
elektromagnetické vlny, např. mikrovlnné trouby, monitory, elektrické motory 
atd. 

 

7. Zapomněli jste šifrovací klíč 

  Resetujte DI-524, aby se obnovilo výchozí tovární nastavení, a obnovte vý-
chozí nastavení také u všech zařízení v síti. Resetovací tlačítko je umístěno 
vzadu na směrovači. Resetováním ztratíte aktuální nastavení konfigurace. 
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8. Resetování DI-524 na výchozí tovární nastavení 

Po vyzkoušení všech ostatních způsobů pro řešení potíží ve vaší síti můžete 
zkusit resetovat DI-524 na výchozí tovární nastavení. Zařízení D-Link AirPro jsou 
výrobcem nastavena tak, aby při výchozím nastavení vytvořila síťové spojení. 

 

Pro tvrdé resetování DI-524 na výchozí tovární nastavení proveďte tyto kroky: 

  Najděte vzadu na DI-524 tlačítko Reset. 

  Pomocí narovnané sponky na papír stiskněte tlačítko Reset. 

  Držte tlačítko stisknuté asi 10 sekund a pak je uvolněte. 

  Po restartování DI-524 (může to trvat několik minut) se obnoví výchozí tovární 
nastavení. 

Reset 
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Standardy  

 IEEE 802.11g   

 IEEE 802.11b 

 IEEE 802.3  

 IEEE 802.3u   

VPN tunelování/vícenásobné relace 

 PPTP  

 L2TP  

 IPSec 

Správa zařízení 

 Webové rozhraní – Internet Explorer v. 6 nebo vyšší, Netscape Navi-
gator v. 7 nebo vyšší nebo jiné prohlížeče s podporou jazyka Java.  

 DHCP server a klient 

Pokročilé firewallové funkce 

 NAT s VPN tunelováním (Network Address Translation) 

 Filtrování MAC 

 Filtrování IP 

 Filtrování URL 

 Blokování domén 

 Časový rozvrh 

Dosah bezdrátového spojení 

 Uvnitř budov – až 100 m 

 Venku – až 300 m 

Provozní teplota 

 0 až 55 °C 

Vlhkost 

 max. 95 % (nekondenzující) 

Bezpečnost a vyzařování 

 FCC, CE 

Frekvenční pásmo bezdrátového přenosu 

 2,4 až 2,462 GHz  
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LED indikátory 

 Power (napájení) 

 WAN (internet) 

 LAN (10/100) (lokální síť) 

 WLAN (bezdrátové spojení)  

Rozměry 

 Délka = 142 mm 

 Šířka = 109 mm 

 Výška = 31 m 

Výkon bezdrátového vysílání 

 14 dBm 

Zabezpečení 

 802.1x 

 WEP 

 WPA 

 WPA-PSK 

Typ externí antény 

 Jedna odpojitelná s reverzním SMA konektorem 

Typ modulace 

  OFDM (Orthogonal Frequency Division Multiplexing) 

Napájení 

 Externí napájecí zdroj 7,5 V ss, 1,5 A 

Hmotnost 

 200 g 

Záruka 

 1 rok 
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Rychlosti bezdrátového přenosu dat (automatické přizpůsobení) 

 54 Mb/s 

 48 Mb/s 

 36 Mb/s 

 24 Mb/s 

 18 Mb/s 

 12 Mb/s 

 11 Mb/s 

 9 Mb/s 

 6 Mb/s 

 5,5 Mb/s 

 2 Mb/s 

 1 Mb/s 

Citlivost přijímače 

 54Mb/s OFDM, 10% PER, -68dBm 

 48Mb/s OFDM, 10% PER, -68dBm 

 36Mb/s OFDM, 10% PER, -75dBm 

 24Mb/s OFDM, 10% PER, -79dBm 

 18Mb/s OFDM, 10% PER, -82dBm 

 12Mb/s OFDM, 10% PER, -84dBm 

 11Mb/s CCK, 8% PER, -82dBm 

 9Mb/s OFDM, 10% PER, -87dBm 

 6Mb/s OFDM, 10% PER, -88dBm 

 5,5Mb/s CCK, 8% PER, -85dBm 

 2Mb/s  QPSK, 8% PER, -86dBm 

 1Mb/s BPSK, 8% PER, -89dBm 
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Nejčastější dotazy (FAQ) 
 

 
 
Když zadáváte IP adresu DI-524 (192.168.0.1), nepřipojujete se k Internetu ani 
k němu nemusíte být připojeni. Zařízení má paměť ROM obsahující funkci pro ko-
munikaci. Pro vyvolání webového rozhraní musí být počítač ve stejném intervalu IP 
adres (podsíti). 
 
Pro vyřešení potíží s vyvoláním webového rozhraní konfigurace postupujte takto: 
 

Krok 1 Zkontrolujte fyzické připojení tak, že zkontrolujete, zda příslušný indikátor 

LAN trvale svítí. Pokud indikátor trvale nesvítí, zkuste použít jiný kabel nebo použijte 
pro připojení jiný port, pokud je to možné. Je-li počítač vypnut, neměl by indikátor 
svítit. 
 

Jaký typ kabelu by se měl použít? 

 
Překřížený kabel vyžadují následující připojení: 
Počítač – Počítač 
Počítač – Uplink 
Počítač – Přístupový bod 
Počítač – Tiskový server 
Počítač/XBOX/PS2 – DWL-810 
Počítač/XBOX/PS2 – DWL-900AP+ 
Uplink – Uplink (rozbočovač/přepínač) 
Normální port – Normální port (rozbočovač/přepínač) 
 
Přímý (nepřekřížený) kabel vyžadují následující připojení: 
Počítač – Rezidentní brána/směrovač 
Počítač – Normální port (rozbočovač/přepínač) 
Přístupový bod  – Normální port (rozbočovač/přepínač) 
Tiskový server  – Normální port (rozbočovač/přepínač) 
Uplink – Normální port (rozbočovač/přepínač) 

 
Pravidlo: 
„Pokud svítí indikátor linky, je kabel v pořádku.“ 
 

Proč nelze vyvolat webové rozhraní konfigurace? 
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Nejčastější dotazy (pokračování) 

 

Jaký typ kabelu by se měl použít? (pokračování) 

Jaký je rozdíl mezi překříženým a přímým kabelem? 

Zapojení vodičů v překříženém a přímém 
kabelu se liší. Tyto dva typy kabelů mají pro 
různé konfigurace LAN různý účel. Stan-
dardní zapojení definuje EIA/TIA 568A/568B 
a dovoluje použít dva různé způsoby barev-
ného značení vodičů, jak ukazuje následují-
cí obrázek. 
*Vodiče mohou mít na barevném podkladu 
izolace bílé pruhy a mohou tak být označe-
ny i na obrázcích v jiných publikacích. 

Jak poznat přímý kabel od překříženého? 
Hlavní způsob, jak poznat rozdíl mezi obě-
ma typy kabelů, je porovnat pořadí vodičů 
na konci kabelů. Je-li pořadí vodičů na obou 
koncích stejné, je to přímý kabel. Je-li na jedné straně jiné pořadí vodičů než na 
druhé, je to překřížený kabel. 
 
Vše, co potřebujete znát pro správné použití kabelů, je pořadí vývodů na obou 
koncích kabelu a následující pravidla: 
Přímý kabel má stejné konce. 
Překřížený kabel má různé konce. 

 
Z hlediska funkce nehraje žádnou roli, jaký standard použijete pro výrobu přímé-
ho kabelu, pokud jsou oba konce stejné. Při výrobě překříženého kabelu můžete 
začít kterýmkoli standardem, pokud bude druhý konec jiný. Z hlediska funkce ne-
záleží na tom, který konec je který. Důležité je pořadí připojení vodičů ke kontak-
tům. Použití jiného vzoru, než který je uveden na obrázku výše, by mohlo způso-
bit potíže se spojením.¨ 
 
Kdy použít překřížený a kdy přímý kabel 
Počítač – Počítač: překřížený 
Počítač – Normální port na rozbočovači/přepínači: přímý 
Počítač – Uplink port rozbočovače/přepínače: překřížený 
Uplink port rozbočovače/přepínače – Uplink port jiného rozbočovače/přepínače: 

překřížený 
Uplink port rozbočovače/přepínače – Normální port rozbočovače/přepínače: pří-

mý 

Proč nelze vyvolat webové rozhraní konfigurace? (pokračování) 

1 Bílá-Zelená 
2 Zelená 
3 Bílá-Oranžová 
4 Modrá 
5 Bílá-Modrá 
6 Oranžová 
7 Bílá-Hnědá 
8 Hnědá 

1 Bílá-Oranžová 
2 Oranžová 
3 Bílá-Zelená 
4 Modrá 
5 Bílá-Modrá 
6 Zelená 
7 Bílá-Hnědá 
8 Hnědá 

Konec kabelu 568A 

Konec kabelu 568B 
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Krok 2 Zablokujte na počítači všechny programy zajišťující bezpečný přístup na 

Internet. Softwarové firewally jako ZoneAlarm, Black Ice, Sygate, Norton Personal 
Firewall atd. mohou blokovat přístup ke konfiguračním stránkám. Další informace 
o vyřazení nebo změně konfigurace softwarového firewallu najdete v dokumentaci 
dodávané k programu. 
 

Krok 3 Nakonfigurujte nastavení pro Internet.  

 
Jděte na Start > Nastavení (Settings) > Ovládací panely 
(Control Panel). Klikněte dvojitě na ikonu Možnosti In-
ternetu (Internet Options). 
 

 

 

 
Klikněte na záložku Připojení (Connection) a nastavte te-
lefonické připojení na Nikdy nevytáčet připojení (Never 
Dial a Conection).  
Klikněte na Nastavení místní sítě (LAN Settings). 
 
 

 

 
 
 
Není třeba nic zadávat. Klikněte na OK. 

 

 
 
Přejděte na záložku Upřesnit (Advanced) a klikněte na 
Obnovit výchozí nastavení. 
 
 
Klikněte na OK. Přejděte na pracovní plochu a zavřete 
všechna otevřená okna. 

 

 

Proč nelze vyvolat webové rozhraní konfigurace? (pokračování) 
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Krok 4 Zkontrolujte svoji IP adresu. Počítač musí mít IP adresu ze stejného interva-

lu jako zařízení, které chcete nakonfigurovat. Většina zařízení D-Link používá inter-
val 192.168.0.X. 

Jak mohu zjistit svoji IP adresu ve Windows 95/98/Me? 

Krok 1 Klikněte na Start a pak na Spustit (Run). 
 
Krok 2 Objeví se dialogový rámeček Spustit (Run). Zadejte do vstupního pole 
winipcfg, jak ukazuje obrázek, a klikněte na OK. 
 

 
 
Krok 3 Objeví se okno Konfigurace IP (IP Configuration) a zobrazí se informace 
o ethernetovém adaptéru.  

 Vyberte z rozvinovacího seznamu váš adaptér. 

 Pokud adaptér v seznamu nenajdete, není správně nainstalován. 
 

 
 

Krok 4 Po vybrání adaptéru se zobrazí jeho IP adresa, maska podsítě a výchozí 
brána. 
 
Krok 5 Klikněte na OK, abyste zavřeli okno Konfigurace IP. 

 

Proč nelze vyvolat webové rozhraní konfigurace? (pokračování) 
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Nejčastější dotazy (pokračování) 

 

Krok 4 (pokračování) Zkontrolujte svoji IP adresu. Váš počítač musí mít IP adresu 

ze stejného intervalu jako zařízení, které chcete nakonfigurovat. Většina zařízení  
D-Link používá interval 192.168.0.X. 
 

Jak mohu zjistit svoji IP adresu ve Windows 2000/XP? 

Krok 1 Klikněte na Start a vyberte Spustit (Run). 
 
Krok 2 Zadejte do vstupního pole cmd a klikněte na OK. 

 

 
 

Krok 3 V příkazovém řádku zadejte ipconfig. Zobrazí se vaše IP adresa, maska 
podsítě a výchozí brána. 

 

 
 

Krok 4 Zadejte exit, abyste ukončili příkazový řádek.  
 

Proč nelze vyvolat webové rozhraní konfigurace? (pokračování) 
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Nejčastější dotazy (pokračování) 

 

Krok 4 (pokračování) Zkontrolujte svoji IP adresu. Váš počítač musí mít IP adresu 

ze stejného intervalu jako zařízení, které chcete nakonfigurovat. Většina zařízení  
D-Link používá interval 192.168.0.X. 

Všimněte si IP adresy výchozí brány na počítači. Výchozí brána je IP adresa směro-
vače D-Link. Výchozí nastavení by mělo být 192.168.0.1. 
 

Jak mohu nastavit statickou IP adresu ve Windows XP? 

Krok 1 Klikněte na Start > Ovládací panely (Control Panel) > Připojení k síti a 
Internetu (Network and Internet Connections) > Síťová připojení (Network Con-
nections). 
 
Krok 2 Dále pokračujte krokem 2 pro Windows 2000. 

 

Jak mohu nastavit statickou IP adresu ve Windows 2000? 

 
Krok 1 Klikněte pravým tlačítkem na 
Místa v síti (My Network Places) a 
vyberte Vlastnosti (Properties). 
 
Krok 2 Klikněte pravým tlačítkem na 
Připojení k místní síti (Local Area 
Connection), které reprezentuje vaši 
síťovou kartu, a vyberte Vlastnosti 
(Properties). 
 
 
 
 
Krok 3 Vyberte Protokol sítě Inter-
net (TCP/IP) (Internet Protocol 
TCP/IP) a klikněte na Vlastnosti 
(Properties). 

 

 

 
 

Proč nelze vyvolat webové rozhraní konfigurace? (pokračování) 



71 

Nejčastější dotazy (pokračování) 

 

Jak mohu nastavit statickou IP adresu ve Windows 2000?  
(pokračování) 

Klikněte na Použít následující adresu IP 
(Use the following IP address) a zadejte IP 
adresu, která patří do stejné podsítě jako 
LAN IP adresa směrovače.  
Příklad: 
Pokud je LAN IP adresa směrovače 
192.168.0.1, zadejte svoji IP adresu jako 
192.168.0.X, kde X = 2–99. Zkontrolujte, 
zda se vybraná adresa ve vaší síti nepou-
žívá. 
 
Nastavte Výchozí bránu (Default Gate-
way) tak, aby byla stejná jako LAN IP adre-
sa směrovače (1892.168.0.1). 

  

Nastavte jako Upřednostňovaný server DNS (Prefered DNS Server) LAN IP ad-
resu směrovače (192.168.0.1). 

Náhradní server DNS (Alternate DNS Server) není zapotřebí nebo můžete zadat 
DNS server od vašeho ISP. 

Klikněte dvakrát na OK. Může se objevit požadavek na restartování. Klikněte na 
Ano (Yes).  

Jak mohu nastavit statickou IP adresu ve Windows 98/Me? 

Krok 1 Na pracovní ploše klikněte pravým 
tlačítkem na ikonu Okolní počítače 
(Network Neigborhood) (My Network Pla-
ces ve Windows Me) a vyberte Vlastnosti 
(Properties). 
 
Vyberte TCP/IP a klikněte na Vlastnosti 
(Properties). Máte-li více než 1 síťovou 
kartu, bude zde pro každý adaptér „vazba“ 
na TCP/IP. Vyberte příslušné spojení 
TCP/IP > síťový adaptér a pak klikněte na 
Vlastnosti (Properties). 

 

Proč nelze vyvolat webové rozhraní konfigurace? (pokračování) 
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Nejčastější dotazy (pokračování) 

 

Jak mohu nastavit statickou IP adresu ve Windows 98/Me? 
(pokračování) 

Krok 2 Klikněte na Zadat IP adresu ručně (Specify 
an IP Address). 

 Zadejte IP adresu, která patří do stejné podsí-
tě jako LAN IP adresa směrovače. 

 Příklad: 
 Pokud je LAN IP adresa směrovače 

192.168.0.1, zadejte svoji IP adresu jako 
192.168.0.X, kde X = 2–99. Zkontrolujte, zda 
se vybraná adresa ve vaší síti nepoužívá. 

Krok 3 Klikněte na záložku Brána (Gateway). 

 Zde zadejte LAN IP adresu směrovače 
(192.168.0.1). 

 Klikněte na Přidat (Add). 

Krok 4 Klikněte na záložku Konfigurace DNS (DNS 
Configuration). 

 Klikněte na Povolit používání serveru DNS 
(Enable DNS). Zadejte Hostitele (Host) (může 
to být libovolné slovo). V Pořadí hledání ser-
veru DNS (DNS server search order) zadejte 
LAN IP adresu směrovače (192.168.0.1) a 
klikněte na Přidat (Add). 

Krok 5 Klikněte dvakrát na OK. 

 Po výzvě k restartování počítače klikněte na 
Ano (Yes). 

 Po restartování bude mít počítač statickou IP 
adresu. 

 

 

 

 

Krok 5 Vyvolejte webové konfigurační rozhraní. Spusťte webový prohlížeč a jako 

adresu zadejte IP adresu zařízení D-Link. Tím by se měla otevřít přihlašovací strán-
ka webové konfigurace. Postupujte podle pokynů pro přihlášení a dokončete konfi-
guraci. 

Proč nelze vyvolat webové rozhraní konfigurace? (pokračování) 
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Nejčastější dotazy (pokračování) 

 

Dynamické kabelové připojení 
(IE AT&T-BI, Cox, Adelphia, Rogers, Roadrunner, Charter a Comcast) 

Poznámka: Nakonfigurujte směrovač pomocí počítače, který byl naposledy připojen 
přímo ke kabelovému modemu. 
 

Krok 1 Přihlaste se do webového konfiguračního rozhraní zadáním IP adresy smě-

rovače (výchozí: 192.168.0.1) ve webovém prohlížeči. Jméno uživatele (User Name) 
je admin (malými písmeny) a heslo (Password) se nezadává. 

Krok 2 Klikněte na záložku Home a pak na 

tlačítko WAN. Výchozí nastavení je Dynamic IP 
Address. Pokud není tato volba nastavena, 
klikněte na přepínací tlačítko Dynamic IP 
Address. Klikněte na Clone MAC Address. 
Klikněte na Apply a pak na Continue, aby se 
změny uložily. 

 
 

 

Jak nastavit směrovač pro kabelový modem? 
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Nejčastější dotazy (pokračování) 

 

Krok 3 Postup pro zapnutí kabelového modemu a směrovače. 

Vypněte kabelový modem (jako první). Vypněte směrovač a nechejte obě zařízení 
vypnutá po dobu 2 minut.** Zapněte kabelový modem (jako první). Počkejte, dokud 
na modemu nezačne svítit indikátor kabelového spojení. Zapněte směrovač. Počkej-
te 30 sekund. 

** Máte-li Modem Motorola (SurfBoard), nechejte zařízení vypnutá nejméně 5 minut. 

Krok 4 Vraťte se do kroku 1 a přihlaste se znovu do webové konfigurace. Klikněte 

na záložku Status a pak klikněte na tlačítko Device Info.  

Pokud ještě nemáte pod hlavičkou WAN veřejnou IP adresu, klikněte na tlačítko 
DHCP Renew a pak na Continue. 

Statické kabelové připojení 

Krok 1 Přihlaste se do webového konfigurační-

ho rozhraní zadáním IP adresy směrovače (vý-
chozí: 192.168.0.1) ve webovém prohlížeči. 
Jméno uživatele (User Name) je admin (malými 
písmeny), heslo (Password) se nezadává. 

Krok 2 Klikněte na záložku Home a pak na 

tlačítko WAN. Nastavte Static IP Address a do 
příslušných polí zadejte nastavení pro statickou 
IP adresu, která jste získali od ISP. 

 

 

Pokud nastavení neznáte, musíte 
kontaktovat vašeho ISP. 

Krok 3 Klikněte na Apply a pak 

na Continue, aby se změny uloži-
ly. 

Krok 4 Klikněte na záložku Sta-

tus a pak na tlačítko Device Info. 
Pod hlavičkou WAN se zobrazí 
informace o vaší IP adrese. 

 

 
 

Jak nastavit směrovač pro kabelový modem? (pokračování) 
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Nejčastější dotazy (pokračování) 

 

Ujistěte se, že jste na počítači zablokovali nebo odinstalovali všechny PPPoE pro-
gramy, jako WinPoet nebo Ethernet 300, jinak se nebudete moci připojit k Internetu. 

Krok 1 Je zapotřebí provést upgrade firmwaru. 

(Informace o nejnovější verzi firmwaru vyhledejte na stránkách technické podpory  
D-Link na adrese: http://support.dlink.com) 

Krok 2 Pomocí narovnané sponky na papír proveďte tvrdý reset. Mějte přístroj 

zapnutý, vezměte sponku a stiskněte resetovací tlačítko vzadu na přístroji po dobu 
10 sekund. Uvolněte tlačítko. Směrovač začne obnovovat svoji funkci, indikátory 
budou blikat a pak se ustálí. 

Krok 3 Po stabilizaci směrovače spusťte webový prohlížeč, po pole adresy zadejte 

192.168.0.1 a stiskněte klávesu Enter. Když se objeví přihlašovací dialogový ráme-
ček, zadejte jako jméno uživatele (User Name) admin a heslo (Password) nechejte 
prázdné. Klikněte na OK. 

Pokud se přihlašovací dialogový rámeček neobjeví, opakujte Krok 2. 

Poznámka: Nespouštějte funkci automatického nastavení (Run Wizard). 

Krok 4 Klikněte na záložku WAN v levé části okna. Zvolte PPPoE. 

Krok 5 Zvolte Dynamic PPPoE (pokud vám váš ISP nepřidělil statickou IP adresu). 

Krok 6 V poli jména uživatele zadejte ELN/username@earthlink.net a vaše heslo, 

kde username je vaše vlastní jméno uživatele. 

Uživatelé SBC Global zadávají username@sbcglobal.net. 
Uživatelé Ameritech zadávají username@ameritech.net. 
Uživatelé BellSouth zadávají username@bellsouth.net. 
Uživatelé Mindspring zadávají username@mindspring.net. 
U většiny ostatních ISP se zadává username. 

Krok 7 Maximum Idle Time (Maximální dob prodlevy) by se měla nastavit na nulu. 

Nastavte MTU na 1492, pokud ISP nestanoví jinak, a nastavte Autoreconnect na 
Enabled. 

Poznámka: Pokud nastanou potíže s přístupem k některým stránkám nebo emailo-
vým službám, nastavte hodnotu MTU na menší číslo, např. 1472, 1452 atd. Požádej-
te ISP o další informace a správné nastavení MTU. 

 

Jak nastavit směrovač pro Earthlink DSL nebo jiné PPPoE připoje-
ní? 
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Nejčastější dotazy (pokračování) 

 

Krok 8 Klikněte na Apply. Po výzvě klikněte na Continue. Když se obsah okna 

obnoví, odpojte napájení směrovače. 

Krok 9 Vypněte DSL modem na 2–3 minuty. Pak jej znovu zapněte. Když modem 

obnoví činnost a naváže spojení s ISP, připojte ke směrovači znovu napájení. Po-
čkejte asi 30 sekund a pak se znovu přihlaste do konfiguračního menu směrovače. 

Krok 10 Klikněte na záložku Status ve webové konfiguraci, kde můžete vidět in-

formace o zařízení. Pod WAN klikněte na Connect. Po výzvě klikněte na Continue. 
Nyní byste měli vidět, že se v informaci o zařízení zobrazuje IP adresa, což potvrzu-
je, že zařízení bylo připojeno k serveru a byla mu přidělena IP adresa 
 

 

Ve většině případů ano. AOL DSL+ může používat PPPoE pro autorizovaný přístup 
ke  klientskému softwaru. Jde-li o tento případ, pak naše směrovače budou s touto 
službou pracovat. Nejste-li si jisti, kontaktujte AOL. 

Nastavení směrovače: 

Krok 1 Přihlaste se do webového konfiguračního menu (192.168.0.1) a nakonfigu-

rujte WAN pro použití PPPoE. 

Krok 2 Jako jméno uživatele zadejte svoje přihlašovací jméno následované 

@aol.com. Do pole hesla zadejte vaše heslo AOL. 

Krok 3 MTU budete muset nastavit na 1400. AOL DSL nedovoluje nic vyššího než 

1400. 

Krok 4 Použijte změny (Apply). 

Krok 5 Vypněte na 1 minutu modem a pak na jednu minutu směrovač. Nechejte 1 

až 2 minuty na připojení. 

Připojujete-li se k Internetu přes jiného ISP a chcete používat software AOL, můžete 
to udělat bez konfigurace nastavení firewallu směrovače. Musíte nakonfigurovat 
software AOL pro připojení pomocí TCP/IP. 

Další informace o softwaru AOL najdete na http://www.aol.com 

 

Mohu použít směrovač pro sdílení připojení k Internetu poskytova-
ného AOL DSL Plus? 

Jak nastavit směrovač pro Earthlink DSL nebo jiné PPPoE připoje-
ní? (pokračování) 

http://www.aol.com/
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Nejčastější dotazy (pokračování) 

 

Abyste umožnili přístup z Internetu do vaší lokální sítě, budete muset otevřít porty na 
směrovači, jinak bude směrovač tyto požadavky blokovat. 

Krok 1 Spusťte webový prohlí-

žeč a zadejte IP adresu směro-
vače D-Link (192.168.0.1). Za-
dejte jméno uživatele (admin) a 
heslo (standardně prázdné). 

Krok 2 Klikněte nahoře na 

Advanced a pak klikněte vlevo 
na Virtual Server. 

Krok 3 Aktivujte nastavení 

kliknutím na Enabled. 
 

Krok 4 Zadejte jméno položky virtuálního serveru. 

Krok 5 V poli Private IP zadejte IP adresu počítače v lokální síti, který chcete zpří-

stupnit příchozí službě. 

Krok 6 Zvolte typ protokolu Protocol Type – TCP, UDP nebo oba (Both). Pokud si 

nejste jisti, zvolte oba. 

Krok 7 Vyplňte pole Private Port a Public Port. Oba porty jsou obvykle stejné. 

Public port (veřejný) je port viditelný ze strany WAN, Private port (soukromý) je port 
používaný aplikací na počítači v místní síti. 

Krok 8 Zadejte časový rozvrh (Schedule). 

Krok 9 Klikněte na Apply a pak na Continue. 

Poznámka: Zkontrolujte, zda je hostitel DMZ vypnut. Je-li DMZ zapnuta, zablokuje 
všechny položky virtuálního serveru. 

Protože naše směrovače používají NAT (Network Address Translation), můžete 
otevřít v daném čase určitý port jen na jednom počítači. Příklad: Máte-li ve vaší síti 2 
webové servery, nemůžete na obou počítačích otevřít port 80. Musíte nakonfigurovat 
jeden z webových serverů tak, aby používal port 81. Nyní můžete otevřít port 80 pro 
první počítač a pak otevřít port 81 pro druhý počítač. 

Jak otevřít porty na směrovači? 
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Nejčastější dotazy (pokračování) 

 

Demilitarizovaná zóna: 

V počítačových sítích je DMZ (demilitarizovaná zóna) hostitelský počítač nebo malá 
síť, vložená jako neutrální zóna mezi firemní privátní síť a vnější veřejnou síť. Za-
braňuje uživatelům z vnějšku získat přímý přístup k serveru, který obsahuje firemní 
data. (Tento termín pochází geografické nárazníkové zóny, která byla ustanovena 
mezi Severní Koreou a Jižní Koreou podle politického rozhodnutí OSN na počátku 
50. let 20. století.) DMZ je doplňková a bezpečnější obdoba firewallu a účinně slouží 
také jako proxy server. 

V typické konfiguraci DMZ pro malé firmy přijímá samostatný počítač (neboli v síťové 
terminologii hostitel) od uživatelů v privátní síti požadavky na přístup k webovým 
stránkám nebo jiným službám dostupným ve veřejné síti. Hostitel DMZ pak spustí 
relace pro tyto požadavky na veřejnou síť. Hostitel DMZ však nemůže spustit relaci 
zpět do privátní sítě. Může předávat nazpět jen pakety, které byly předem vyžádány. 

Uživatelé veřejné sítě mimo firmu mohou mít přístup jen k hostiteli DMZ. Na DMZ 
mohou být obvykle také webové stránky firmy, které jsou tak zpřístupněny vnějšímu 
světu. DMZ však neposkytuje přístup k žádným dalším firemním datům. V případě, 
že vnější uživatel naruší bezpečnost hostitele DMZ, mohou být poškozeny webové 
stránky, nemělo by to však ovlivnit žádná další firemní data. D-Link, přední výrobce 
směrovačů, je jedinou společností, která prodává výrobky určené pro nastavení 
DMZ. 

 

Funkce DMZ umožňuje nasměrovat všechny příchozí požadavky na přístup k portu 
na jeden počítač v místní síti. DMZ neboli demilitarizovaná zóna umožní, aby byl 
určitý počítač přístupný z Internetu. DMZ je užitečná pro případ, že určitá aplikace 
nebo hra nefunguje přes firewall. Počítač, který je nakonfigurován pro DMZ, bude 
zcela vystavený na Internetu, takže se před použitím DMZ doporučuje nejprve zkusit 
otevřít porty z virtuálního serveru nebo nastavení  firewallu. 

Krok 1 Zjistěte IP adresu počítače, který chcete použít jako hostitele DMZ. 

Postup pro zjištění IP adresy počítače ve Windows XP/2000/Me/9x nebo v operač-
ních systémech počítačů Macintosh viz krok 4 první otázky v této kapitole (Nejčastě-
jší dotazy). 

Jak nakonfigurovat hostitele DMZ? 

Co je DMZ? 
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Nejčastější dotazy (pokračování) 

 

Krok 2 Přihlaste se do webového konfigu-

račního rozhraní zadáním IP adresy směro-
vače (výchozí: 192.168.0.1) ve webovém 
prohlížeči. Jméno uživatele (User Name) je 
admin (malými písmeny) a heslo 
(Password) je prázdné. 
 

 

Krok 3 Klikněte na záložku Advanced a pak klikněte na tlačítko DMZ. Zvolte Ena-

ble a zadejte IP adresu, kterou jste zjistili v kroku 1. 

 

Krok 4 Klikněte na 

Apply a pak na Con-
tinue, aby se změny 
uložily. 
 
Poznámka: Když je 
DMZ zapnuta, bude 
nastavení virtuálního 
serveru stále funkční. 
Pamatujte, že nemů-
žete směrovat stejný 
port na více IP adres, 
takže nastavení virtu-
álního serveru bude 
mít přednost před 
nastavením DMZ. 

 
 
 

Jak nakonfigurovat hostitele DMZ? (pokračování) 
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Nejčastější dotazy (pokračování) 

 

Krok 1 Vyvolejte webové konfigurační rozhraní směrovače zadáním IP adresy 

směrovače do webového prohlížeče. Výchozí IP adresa je 192.168.0.1. Přihlaste se 
pomocí hesla. Výchozí jméno uživatele je admin a heslo je prázdné. 

Máte-li potíže s vyvoláním webové konfigurace, podívejte se na první dotaz v této 
kapitole. 

Krok 2 Ve webovém rozhraní přejděte ze záložky Home do záložky Advanced a 

pak klikněte na tlačítko Firewall. 

Krok 3 Klikněte na 

Enabled a zadejte 
název nového pravi-
dla. 

Krok 4 Jako zdroj 

(Source) zvolte WAN 
a zadejte interval IP 
adres na Internetu, 
pro které chcete toto 
pravidlo použít. 
Chcete-li, aby toto 
pravidlo umožnilo 
přístup k portům 
všem uživatelům 
Internetu, zadejte do 
prvního pole hvěz-
dičku a druhé nechej-
te prázdné. 

 
Krok 5 Jako cíl (Destination) vyberte LAN a zadejte IP adresu počítače ve vaší 

místní síti, k němuž chcete povolit přístup příchozím službám. Toto nastavení nepra-
cuje s intervalem IP adres. 

Krok 6 Zadejte port nebo interval portů, které je třeba mít otevřené pro příchozí 

službu. 

Krok 7 Klikněte na Apply a pak klikněte na Continue. 

Poznámka: Ujistěte se, že je hostitel DMZ zablokován. 
Protože naše směrovače používají NAT (Network Address Translation), můžete 
otevřít v daném čase určitý port jen na jednom počítači. Příklad: Máte-li ve vaší síti 2 
webové servery, nemůžete na obou počítačích otevřít port 80. Musíte nakonfigurovat 
jeden z webových serverů tak, aby používal port 81. Nyní můžete otevřít port 80 pro 
první počítač a pak otevřít port 81 pro druhý počítač. 

Jak otevřít skupinu portů na směrovači pomocí pravidel firewallu? 
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Nejčastější dotazy (pokračování) 

 

Virtuální server je definován jako servisní port a všechny požadavky na tento port 
budou přesměrovány na počítač určený IP adresou serveru. Máte-li například FTP 
server (port 21) na 192.168.0.5 a webový server (port 80) na 192.168.0.6 a VPN 
server na 192.168.0.7, pak musíte zadat následující mapovací tabulku virtuálních 
serverů. 

Port serveru IP serveru Povoleno 

21 192.168.0.5 X 

80 192.168.0.6 X 

1723 192.168.0.7 X 

 

 

V sekci Virtual Server na směrovači D-Link budete muset otevřít 3 porty. 

Krok 1 Spusťte webový prohlížeč a zadejte IP adresu směrovače (192.168.0.1). 

Krok 2 Klikněte nahoře na Advanced a pak klikněte vlevo na Virtual Server. 

Krok 3 Zadejte níže 

uvedené parametry. 
Private IP je IP adresa 
počítače v místní síti, 
který chcete připojit. 

Krok 4 První záznam 

bude vypadat tak, jak 
ukazuje obrázek. 

Krok 5 Klikněte na 

Apply a pak klikněte na 
Continue. 

 
 

Jak používat PC Anywhere se směrovačem DI-524? 

Co jsou virtuální servery? 
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Nejčastější dotazy (pokračování) 

 

Krok 6 

Vytvořte 
druhý 
záznam 
podle 
obrázku. 
 
 
 
 
 

Krok 7 

Klikněte 
na Apply 
a pak 
klikněte 
na Conti-
nue. 

 

Krok 8 

Vytvořte 
třetí a 
poslední 
záznam 
podle 
obrázku. 
 
 

 
Krok 9 Klikněte na Apply a pak klikněte na Continue. 

 

Krok 10 Spusťte na vzdáleném počítači PC Anywhere a použijte WAN IP adresu 

směrovače, ne IP adresu vašeho počítače. 

Jak používat PC Anywhere se směrovačem DI-524? (pokračování) 
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Nejčastější dotazy (pokračování) 

 

Při používání programu eDonkey musíte otevřít porty na směrovači, abyste umožnili 
vstup příchozí komunikace. 

eDonkey používá  tři porty (4, pokud se používá CLI): 

4661 (TCP) Pro připojení k serveru. 
4662 (TCP) Pro komunikaci s ostatními klienty. 
4665 (UDP) Pro komunikaci s jinými servery, než ke kterému jste připojeni. 
4663 (TCP) *Použit s klientem příkazového řádku (CLI), když je konfigurován, aby 
umožnil vzdálené spojení. Jde o případ, kdy se u klienta používá grafické rozhraní 
(například Java rozhraní). 

Krok 1 Spusťte webový prohlížeč a zadejte IP adresu směrovače (192.168.0.1). 

Zadejte jméno uživatele (admin) a heslo (standardně prázdné). 

Krok 2 Klikněte na Advanced a pak na Firewall. 

Krok 3 Vytvořte 

nové pravidlo fire-
wallu: Klikněte na 
Enabled. Zadejte 
název (edonkey). 
Klikněte na Allow. 
V řádku Source 
vyberte rozhraní 
(Interface) WAN. V 
prvním poli zadejte 
hvězdičku *. Druhé 
pole nechejte 
prázdné. V řádku 
Destination vyberte 
jako rozhraní LAN. 
Zadejte IP adresu 
počítače, na kterém 
spouštíte eDonkey. 
Druhé pole nechej-
te prázdné. V po-
lích intervalu portů zadejte do prvního pole 4661 a do druhého 4665. Klikněte na 
Always (Vždy) nebo nastavte časový rozvrh. 

Krok 4 Klikněte na Apply a pak klikněte na Continue. 

Jak použít eDonkey za směrovačem D-Link? 
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Nejčastější dotazy (pokračování) 

 

Abyste mohli hrát SOCOM a slyšet zvuk, musíte stáhnout nejnovější firmware pro 
směrovač (je-li zapotřebí), povolit herní režim a otevřít port 6869 pro IP adresu vaší 
Playstation. 

Krok 1 Aktualizujte firmware (viz odkaz výše). 

Krok 2 Spusťte webový prohlížeč a zadejte IP adresu směrovače (192.168.0.1). 

Zadejte jméno uživatele (admin) a heslo (standardně prázdné). 

Krok 3 Klikněte na záložku Advanced a pak klikněte vlevo na Virtual Server.  

Krok 4 Vytvořte novou položku pro virtuální server. Klikněte na Enabled a zadejte 

název (socom). Jako Private IP zadejte IP adresu Playstation. 

Krok 5 Jako Protocol Type zvolte Both. Jako Private Port a Public Port zadejte 

6869. Klikněte na Always. Klikněte na Apply, aby se změny uložily, a pak na Con-
tinue. 

 

Krok 6 Klikněte na záložku Tools a pak vlevo na Misc. 

Krok 7 Zkontrolujte, zda je Gaming Mode nastaven na Enabled. Pokud není, na-

stavte jej. Klikněte na Apply a pak na Continue. 

Jak nastavit směrovač pro SOCOM na Playstation 2? 
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Nejčastější dotazy (pokračování) 

 

Krok 1 Spusťte webový prohlížeč a zadejte IP adresu směrovače (192.168.0.1). 

Zadejte jméno uživatele (admin) a heslo (standardně prázdné). 

Krok 2 Klikněte na záložku Advanced a pak klikněte vlevo na Virtual Server.  

Krok 3 Vytvoříte dvě položky: 

Krok 4 Klikněte na Enabled a 

zadejte toto nastavení: 

Name: Gamespy1 

Private IP: IP adresa počítače, 
na kterém spouštíte Gamespy. 

Protocol Type: Both 

Private Port: 3783 

Public Port: 3783 

Schedule: Always 

Klikněte na Apply a pak na Conti-
nue.  

Krok 5 Klikněte na Enabled a 

zadejte druhou položku: 

Name: Gamespy2 

Private IP: IP adresa počítače, 
na kterém spouštíte Gamespy. 

Protocol Type: Both 

Private Port: 6500 

Public Port: 6500 

Schedule: Always 

Klikněte na Apply a pak na Conti-
nue.  

 

Jak použít Gamespy za směrovačem D-Link? 
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Nejčastější dotazy (pokračování) 

 

Následující postup je určen pro KaZaA, Grokster a další programy, které používají 
systém sdílení souborů FastTrack P2P. 

Ve většině případů nemusíte na směrovači nebo v programu KaZaA nic konfiguro-
vat. Pokud máte potíže, postupujte takto: 

Krok 1 Spusťte webový prohlížeč a zadejte IP adresu směrovače (192.168.0.1).  

Krok 2 Zadejte jméno uživatele (admin) a heslo (standardně prázdné). 

Krok 3 Klikněte na Advanced a pak klikněte na Virtual Server.  

Krok 4 Klikněte na Enabled a zadejte název (např. kazaa).  

Krok 5 Jako Private IP zadejte IP adresu počítače, na kterém spouštíte program 

KaZaA. Jako Protocol Type zvolte TCP.  

Krok 6 Jako Private Port a Public Port zadejte 1214. Klikněte na Always nebo za-

dejte časový rozvrh. Klikněte na Apply. 

 

Ujistěte se, že v programu KaZaA nemáte aktivovanou volbu proxy/firewall. 

 

Jak nakonfigurovat směrovač pro KaZaA a Grokster 



87 

Nejčastější dotazy (pokračování) 

 

Pokud jste hostiteli hry Warcraft 3, musíte otevřít porty na směrovači, abyste umož-
nili vstup příchozí komunikace. Pro hraní hry nemusíte směrovač konfigurovat. 

Warcraft 3 (Battlenet) používá port 6112. 

Pro DI-604, DI-614+, DI-524, 
DI-754, DI-764 nebo DI-774: 

Krok 1 Spusťte webový pro-

hlížeč a zadejte IP adresu smě-
rovače (192.168.0.1). Zadejte 
jméno uživatele (admin) a hes-
lo (standardně prázdné). 

Krok 2 Klikněte na Advanced 

a pak klikněte na Virtual Ser-
ver.  

Krok 3 Vytvořte novou polož-

ku. Klikněte na Enabled a za-
dejte název (warcraft3). Jako 
Private IP zadejte IP adresu 
počítače, který bude hostitelem 
hry. Jako Protocol Type zvolte Both. Jako Private Port a Public Port zadejte 6112. 
Klikněte na Always nebo zadejte časový rozvrh. 

Krok 4 Klikněte na Apply a pak na Continue. 

Poznámka: Pokud chcete, aby se hra, kterou hostíte, dala hrát na několika počíta-
čích ve vaší LAN, opakujte výše uvedené kroky a zadejte IP adresy ostatních počí-
tačů. Budete však muset měnit porty. Počítač 2 může použít port 6113, počítač 3 
může použít port 6114 atd. 

V programu Warcraft 3 budete muset změnit údaje o portu pro počítač 2 a další. 

Nakonfigurujte na všech počítačích informace o portu hry.  
Spusťte na každém počítači Warcraft 3 a klikněte na Options > Gameplay. Listujte 
dolů a měli byste uvidět Game Port. Zadejte číslo portu, které jste nastavili v před-
chozích krocích. 

Jak nakonfigurovat směrovač pro hraní Warcraft 3? 
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Nejčastější dotazy (pokračování) 

 

Na rozdíl od většiny TCP/IP aplikací používá NetMeeting DYNAMICKÉ PORTY 
místo STATICKÝCH PORTŮ. To znamená, že se každé spojení NetMeeting liší od 
předchozího. Například webové HTTP aplikace používají port 80. NetMeeting může 
používat libovolný z více než 60 000 různých portů. 

Žádné  širokopásmové směrovače používající (pouze) standard NAT a žádné pro-
gramy pro sdílení Internetu jako Microsoft ICS, které používají (pouze) standard NAT 
nebudou pracovat s NetMeeting nebo jinými programy na bázi H.323. 

Řešením je nastavit směrovač do režimu DMZ. 

Poznámka: Několik málo výrobců hardwaru se pokusilo zajistit kompatibilitu 
s H.323. Není to jednoduchý úkol, protože směrovač musí kontrolovat každý přícho-
zí paket a zjišťovat, zda by to mohl být paket pro NetMeeting. To přesahuje rámec 
běžné funkce směrovače a může se to stát slabým místem firewallu. D-Link mezi 
tyto výrobce nepatří. 

Více informací najdete na http://www.HomenetHelp.com 

 

 

Při používání iChat musíte na směrovači otevřít porty pro příchozí komunikaci. 

iChat používá následující porty: 5060 (UDP), 5190 (TCP) sdílení souborů, 16384–
16403 (UDP) pro videokonference s ostatními klienty. 

Krok 1 Spusťte webový prohlížeč a zadejte IP adresu směrovače (192.168.0.1). 

Zadejte jméno uživatele (admin) a heslo (standardně prázdné). 

Krok 2 Klikněte na Advanced a pak klikněte na Firewall.  

 

Jak nastavit směrovač pro iChat (Macintosh)? 

Jak používat NetMeeting se směrovačem D-Link? 

http://www.homenethelp.com/
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Krok 3 Vytvořte nové pravidlo firewallu:  

Klikněte na Ena-
bled. Zadejte ná-
zev (ichat1). Klik-
něte na Allow. 
V řádku Source 
vyberte rozhraní 
(Interface) WAN. 
V prvním poli za-
dejte hvězdičku *. 
Druhé pole ne-
chejte prázdné. 
V řádku Destina-
tion vyberte jako 
rozhraní LAN. 
Zadejte IP adresu 
počítače, na kte-
rém spouštíte 
iChat.  

 

Druhé pole nechejte prázdné. Jako protokol zadejte UDP. V polích intervalu portů 
zadejte do prvního pole 5060 a druhé pole nechejte prázdné. Klikněte na Always 
(Vždy) nebo nastavte časový rozvrh. 

 
 

Krok 4 Klikněte na 

Apply a pak klikněte 
na Continue. 

Krok 5 Opakujte 

kroky 3 a 4 a zadejte 
ichat2 a otevřete 
porty 16384–16403 
(UDP). 

 

 
 

Jak nastavit směrovač pro iChat (Macintosh)? (pokračování) 
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Nejčastější dotazy (pokračování) 

 

Pro sdílení souborů: 

Krok 1 Klikněte na 

Advanced a pak klikněte 
na Virtual Server.  

Krok 2 Klikněte na 

Enabled, abyste aktivo-
vali záznam. 

Krok 3 Zadejte název 

položky pro virtuální 
server (ichat3).  

Krok 4 Jako Private IP 

zadejte IP adresu počí-
tače ve vaší místní síti, 
pro který chcete povolit 
příchozí komunikaci.  

Krok 5 Jako Protocol 

Type zvolte TCP.  

Krok 6 Jako Private Port a Public Port zadejte 5190.  

Krok 7 Klikněte na Always nebo zadejte časový rozvrh.  

Krok 8 Klikněte na Apply a pak na Continue. 

Používáte-li Mac OS X Firewall, budete jej možná muset na obou počítačích 
v panelu Sharing preference dočasně vypnout. 

Pro použití Mac OS X Firewall musíte otevřít stejné porty jako na směrovači. 

Krok 1 Zvolte Apple menu > System Preferences. 

Krok 2 Zvolte View > Sharing. 

Krok 3 Klikněte na záložku Firewall. 

Krok 4 Klikněte na New. 

Krok 5 Z menu Port name vyberte Other. 

Krok 6 Do polí Port Number, Range or Series zadejte: 5060, 16384-16403. 

Krok 7 V poli Description zadejte: iChar AV 

Krok 8 Klikněte na OK. 

Jak nastavit směrovač pro iChat (Macintosh)? (pokračování) 
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Nejčastější dotazy (pokračování) 

 

Následující informace pochází z on-line databáze  Macintosh AppleCare. 

Při výchozím nastavení firewallu v Mac OS X nelze v iChatu odesílat nebo přijímat 
soubory. Pokud jste otevřeli AIM port, můžete soubory přijmout, ale nemůžete je 
odeslat. 

Ve výchozím nastavení Mac OS X firewall blokuje přenos souborů pomocí programů 
iChat nebo America Online AIM. Pokud má odesílatel nebo příjemce zapnutý Mac 
OS X firewall, může být přenos blokován. 

Nejjednodušší řešení je dočasně vypnout firewall v panelu Sharing preference na 
obou počítačích. To musí udělat odesílatel. Příjemce však může ponechat firewall 
zapnutý, pokud má otevřený port AIM. Postup pro otevření portu AIM: 

Krok 1 Zvolte Apple menu > System Preferences. 

Krok 2 Zvolte View > Sharing. 

Krok 3 Klikněte na záložku Firewall. 

Krok 4 Klikněte na New. 

Krok 5 Z menu Port name vyberte AOL IM. Mělo by být doplněno číslo portu 

5190. 

Krok 6 Klikněte na OK. 

Pokud nechcete na odesílajícím počítači vypínat firewall, lze místo iChat použít jinou 
službu pro sdílení souborů. Možnosti sdílení souborů v Mac OS X jsou popsány v 
technickém dokumentu 106461, „Mac OS X: File Sharing“ v on-line databázi Apple-
Care. 

Poznámka: Chcete-li použít službu sdílení souborů se zapnutým firewallem, neza-
pomeňte kliknout na záložku Firewall a v seznamu Allow vyberte službu, kterou jste 
si zvolili. Pokud to neuděláte, bude firewall tuto službu sdílení souborů také blokovat. 

Jak odesílat nebo přijímat soubory přes iChat, když je Mac OS X 
firewall zapnutý (Macintosh OS X 10.2 a vyšší) 
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NAT znamená Network Address Translator (Překladač síťových adres). Je navr-
žen a popsán v RFC-1631 a používá se pro řešení problémů s nedostatkem IP ad-
res. V zásadě má každá jednotka NAT tabulku obsahující páry lokálních IP adres a 
globálně jedinečných adres, podle které může tato jednotka „překládat“ lokální IP 
adresy na globální adresu a naopak. Jednoduše řečeno, je to způsob, jak připojit 
mnoho počítačů k Internetu (nebo jiné IP síti) pomocí jedné IP adresy. 

Širokopásmová směrovače D-Link (např. DI-604) podporují NAT. Při správné konfi-
guraci může přes NAT zařízení přistupovat mnoho uživatelů s použitím jediného 
účtu. 

Další informace o RFC-1631: The IP Network Address Translator (NAT) najdete na: 
http://www.faqs.org/rfcs/rfc1631.html 
 

Co je NAT? 

http://www.faqs.org/rfcs/rfc1631.html

